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Welcome
Welcome to Enterprise Cloud.

The Maconomy SaaS Enterprise offering takes Deltek's project-based ERP solution and delivers
it via the cloud to meet the ever-changing needs of large organizations. The cloud delivery of the
powerful Maconomy application allows you to leverage its availability anywhere and at any time.
As the SaaS Administrator for your company, you are responsible for the following:

■ Maintaining role security and user accounts, with the initial assistance of the Implementer
■ Distributing Maconomy access information to all company employees
■ Working with Deltek on service requests related to your SaaS solution
■ Communicating Maconomy Enterprise maintenance times and impacts to all company

employees
■ Submitting customer care requests in the case of any issues

This help site provides you with the information necessary to perform successfully in your role as
a SaaS Administrator.
All SaaS customer accounts are required to have an active/valid SaaS Administrator at all times.

What's New

Check this page often to see updates and additions to guide content.

Date Updates

20 Dec 2024 ■ Added the Configure Ask Dela section
in the Set Up Your Solution menu.

04 Oct 2023 ■ Moved ODBC Add-On Activation
Information topics beneath ODBC
Read-Only Access main topic in the
Extend Your Solution menu.

■ Added spreadsheet link to ODBC User
Access Requests

04 Apr 2022 ■ Added new Configure Spam Filters
topic to the Welcome section of the site.

■ Updated list of Fonts.
■ Updated Disaster Recovery topic.

23 Nov 2021 ■ Updated Install and Configure the
ODBC Driver topic with new link to
HDP driver and updated steps for
installation.
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Date Updates

17 Nov 2021 ■ Added Single Sign-On service request
to Activate Other Features topic.

29 Sep 2021 ■ Added new OS Patching section to 
Planned and Unplanned
Maintenance topic.

09 July 2021 ■ Created new Single Sign-On (SSO)
page with details on third-party
Identity Service Provider support and
supported authentication protocols.

■ Added new Requesting SSO for
Maconomy Enterprise Cloud
information.

■ Changed references to Azure to instead
note third-party Identity Service
Providers in general.

27 May 2021 ■ Updated Live Office Connection topic
to indicate that Live Office is not
activated by default.

■ Updated Activate Other Features
topic to add details on how to submit
service requests.

01 Mar 2021 ■ Updated Single Sign-On (SSO) topic
with OKTA details.

05 Feb 2021 ■ Updated Rich Client Access with
Standard Azure SSO topic to note that
SSO for Business Objects interfaces is
not supported and that OKTA can be
used as a method for SSO.

21 Jan 2021 ■ New Password Policies for Deltek
Cloud AD Accounts section in 
Password Policies topic.

14 Dec 2020 ■ Added Two-Factor Authentication
(2FA) topic.

30 Nov 2020 ■ ODBC Service Request Log template
added toManage ODBC Accounts
topic.
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Date Updates

12 Oct 2020 ■ New Single Sign-On section added to 
Activate Other Features topic.

29 Jan 2020 ■ New Environments content with
descriptions of the Enterprise Cloud
Standard and Enterprise Premium
Cloud environments.

■ New Supported Ad Hoc Service
Requests with ODBC User Access
Requests and Temporary
Performance Environment Booking
content.

■ Minor Integrations content updates.
■ New add-ons added to the Enterprise

Cloud Add-Ons list.

01 Oct 2019 First live publication of help site.

30 July 2019 Updated Service Requests topic with new
timelines.

26 July 2019 Updated Product Overview topic with new
description.

02 July 2019 Added Enable Email Alerts topic.

Product Overview
Deltek offers several different Maconomy Cloud offerings to meet the needs of organizations of all
sizes.

Maconomy Cloud is offered in the following formats: Essentials, Flex, and Enterprise. These
offerings are designed to provide customers with options that meet their organizational needs,
goals, and capabilities.
As an Enterprise customer, the following environment types are available to you:
Enterprise Cloud - Standard Environment
Enterprise Premium Cloud - Standard Environment

Enterprise Cloud- Standard Environments
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Note: Promotions of Basic, Intermediate and Advanced Extensions from Development to Test
and Promotions from Test to Production will be done by Deltek Cloud Ops after a Service
Request is raised by the SaaS Administrator. You can request your Implementer to be able to
raise Service Requests on your behalf by using the Add Additional SaaS Administrator
Service Request and entering the Implementer details.
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Important: The PRIMARY purpose of the Production Support environment is for Deltek to
support your solution. It is not designed first and foremost as a customer-facing environment,
but it can be utilized by customers as long as they understand that at any point in time Deltek
may update this environment in order to triage cases or issues. Additionally, there will never be
development capabilities available for this environment.

Enterprise Premium Cloud - Standard Environments
Enterprise Premium Cloud Customers have a total of 7 Environments for BAU. Development,
Test, UAT, Pre-Production, Production, Production Support and Preview. Enterprise Premium
Cloud Customers also have an additional Project bundle of environments to support any ongoing
Projects without disturbing their BAU environments. Project Development, Project Data Migration
and Project UAT.

Business As Usual Environments
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Note: Promotions of Basic, Intermediate and Advanced Extensions from Development to Test,
from Test to UAT, from UAT to Pre-Production and from Pre-Production to Production will be done
by Deltek Cloud Ops after a Service Request has been raised by the SaaS Administrator. You
can request your Implementer to be able to raise Service Requests on your behalf by using the
Add Additional SaaS Administrator Service Request and entering the Implementer details.
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Project Bundle
 

 

Deltek Support Center
You can access Deltek's Support Center to accomplish several administrator-level tasks.

The Deltek Support Center is a support Web portal for Deltek customers. It is important that you
login and familiarize yourself with the connect site.
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The following are some of the many options you have at the Deltek Support Center site:
■ Raise Service Requests and check on their progress.
■ Search Deltek’s knowledge base.
■ Ask questions, exchange ideas, and share knowledge with other Deltek customers

through the Deltek Connect Customer Forums.
■ Display or download product information, such as release notes, user guides, technical

information, and white papers.
■ Submit a support case and check on its progress.
■ Transfer requested files to a Customer Care analyst.
■ Use Quick Chat to submit a question to a Customer Care analyst online.
■ Subscribe to Deltek communications about your Deltek products and services.

Note: If you need assistance using the Deltek Support Center site, the online help available on
the site provides answers for most questions.

Access Deltek's Support Center
You can access Deltek's Support Center to accomplish several administrator-level tasks.

To access the Deltek Support Center site for the first time, complete the following steps:

1. Go to https://deltek.custhelp.com.
2. On the login page click Need Help? In the Reset Your Password section, enter your

Username and click Send. A temporary password will be emailed to you.
The SaaS Administrator will receive instructions on logging onto the Deltek Support
Center site for the first time in the Activation email sent when the SaaS order process
was completed.

3. When you have received your temporary password enter the details at https://
deltek.custhelp.com and click Log In.
Note: If you do not have a username and password for the Deltek Support Center site,
contact your firm’s Maconomy Administrator.
If you forget your username or password, you can click the Need Help? button on the
login screen for help.

Raise a Service Request
You can raise a Service Request to assign access and to request for administrator account
changes. Service Requests are routine requests for actions to your environments. The majority of
actions will be performed as a result of such requests (Support Cases should only be raised for
Issues in the environments or one off processes where a Service Request does not exist).

Note: As the SaaS Administrator, you will be responsible for raising Service Requests in
the Deltek Support Center. It is also possible to allow your Implementer to raise Service
Requests on your behalf. To do so please use the Add Additional SaaS Administrator
service request.
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To raise a Service Request:

1. Login to https://deltek.custhelp.com.
2. Click on Cloud Solutions and select Maconomy Enterprise.
3. The Service Requests are listed in the bottom right hand corner of the screen.
4. Choose the correct Service Request.
5. Enter the requested details.
6. Submit the Service Request.

Submit a Support Case
You can submit a Support Case to raise questions and system issues. Support cases should be
submitted during system setup when advised by the Implementer. Post Go-Live, they should be
submitted for issues you identify in the system.

To submit a Support Case:

1. Login to https://deltek.custhelp.com.
2. Click Submit Case.
3. Enter a detailed description of the issue and attach any supporting documentation.
4. Click Continue to submit the case.

Note: If a Deltek Support Center contact requires access to your system to triage or
resolve an issue, it is the responsibility of a SaaS Administrator to set up a user account
for them.

Assign Authorized Support Contact
You can assign an Authorized Support Contact to submit your Customer Care Support Cases for
you.

Authorized Support Contacts are named individuals who will be able to submit Customer Care
Support Cases on behalf of the customer. Therefore, if you grant a consultant implementer
access rights to work on your environment and want them to also raise Customer Care Support
Cases you will need to assign them as an Authorized Support Contact. If the consultant is not an
ASC, then they will still be able to work on your environment but they cannot submit support
tickets on the customer’s behalf.
Authorized Support Contacts:

■ Select Care customers can designate up to 15 Authorized Support Contacts
■ Premium Care customers can designate up to 6 Authorized Support Contacts
■ Standard Care customers can designate up to 4 Authorized Support Contacts

See the following Knowledge Base article for further information regarding managing your ASC’s:
https://deltek.custhelp.com/app/answers/detail/a_id/36134/p/875/c/149/kw/Authorized
%20Support%20contacts
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Note: Only SaaS Administrators can raise Service Requests for your Cloud offering. Authorized
Support Contacts are not able to raise Service Requests.

Change SaaS Administrator
You can change the SaaS Administrator listed on your account through a Support Case or via
email.

If your organization needs to change the SaaS Administrator listed on your customer account,
you must submit a support case to Deltek Customer Care as described in the “Submitting a
Support Case” section. The Support Case must be submitted by the current SaaS Administrator.
If the current SaaS Administrator is not available the case can be submitted by any other Support
Contact within the business.
In the event that the SaaS Administrator is no longer with the company and there are no
additional Support Contacts available internally to raise the request for the new SaaS
Administrator, a request must be submitted via email to CCOPS@deltek.com. This request must
include a formal letter on company letterhead and have the signature of the CEO, CFO, or
President of the Company. The request should also include the name of your Company, your
Deltek Client ID, the new SaaS Administrator’s name, email address, title, and phone number.
Alternatively you can fax the request to Deltek at +1.339.469.8970. Absent administrator change
requests are typically completed within 2 business days.
The SaaS Administrator must be a person within the customer’s organization.
Note: A SaaS Administrator has the ability to activate up to 4 other SaaS Administrators. It is the
customer’s responsibility to manage who is given rights to be a SaaS Administrator. Your
consultants do not need to be SaaS Administrators to implement your solution, you can make
them Authorized Support Contacts so they can submit Customer Care cases. It is best practice to
limit the SaaS Administrator role to a select number of individuals within the customer’s
organization.

Configure SPAM Filters
You must make sure that auto-generated emails are allowed through your company's SPAM
filters.

To configure your company's SPAM filters:

1. Allow-list the following email addresses:
■ maconomyenterprise@deltek.com
■ donotreply@deltekenterprise.com
■ donotreply@deltek.com
■ noreply@deltekenterprise.com

2. Configure your email provider's (online or on-premise) SPAM filter or other email filters to
allow inbound email transmissions from the following IP address:
■ Sendgrid: 167.89.11.197
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Note: This IP address range is owned by Sendgrid, an industry leading and secure
email and Web security service. The above IP address is safe and can be trusted
by all Maconomy Cloud customers.
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Set Up Your Solution
This section includes information on Enterprise Cloud environments and initial setup and
configuration of your solution.

Environments
Your account set up is provided with environments intended for development, testing and
production.

You have signed up for the Enterprise Cloud product and the following environments are provided
with your setup.
Note: Access to the Customer Development environment (or related environments intended for
extension development) is described in the Enterprise Cloud SDLC document.

Enterprise Cloud Environments
You can subscribe or purchase features and services that are available only in Deltek Cloud
services premium offerings.

Certain features of the service are only available in premium offerings and are outlined below.
Check with your account manager or your customer success manager if you are interested in
obtaining services that you do not have in your current offering. Additional subscription fees may
apply.

Types of Environments

You can utilize a different type of application environment for a specific purpose.

There are a number of different types of application environments that are available in Deltek’s
SaaS offerings. By our definition, an Environment is the collection of software and infrastructure
necessary to operate one of Deltek’s SaaS products. This includes shared security services,
monitoring, web and application servers, database servers, operating systems, computers,
storage, memory, and networks. Each environment can have one or more customer-specific
database instances associated with it which may or may not require additional subscription fees.
For certain offerings, additional non-production environments, or production or non-production
database replicates may be purchased for a minimum of a 1-year subscription.
Each of these environments has a specific purpose and are available with specific offerings.
There may be additional subscription costs to gain access to some of the environments below.
Production Environments
All Deltek SaaS services provide a production environment that is held to the highest operational
standard. These environment instances are highly secure and managed under strict control. Only
authorized Deltek Cloud Operations employees are allowed access to the infrastructure and
application layers of the solution. Customer access is provisioned through the application front
end only or through very specific tightly controlled methods such as an application specific API
layer. These environments serve as the focal point for Disaster Recovery replication and backup
procedures. Customers generally only have one production instance unless they are running
more than one company or entity under separate subscriptions.

Set Up Your Solution
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Non-Production Environments
Any application environment that is not designated for live production use is by nature a non-
production environment. Service levels for non-production environments differ in several ways
from production environment. For example, a severity 1 service incident is meant for a production
down scenario. Therefore, because non-production environments are not production, the highest
level severity for any incident is a severity 2. There are other key aspects to the service that are
either different or do not apply to certain non-production environments, including back up and
retention, DR, access management, level of access, performance, uptime, and service levels.
Below are definitions of common non-production environments:
Implementation Non-Production Environments
The purpose of this type of non-production environment is to facilitate a customer implementation.
In Essentials and Flex offerings, this environment is only available during implementation.
Availability for these databases and services level objectives will be treated the same as non-
production environments.
Standard Non-Production Environments
Deltek Enterprise Cloud offerings include an always-on Test and Development non-production
environment. The purpose of these environments is to support the implementation and ongoing
development or implementation/configuration work once the customer has gone live on their
production environment. These environments can be refreshed from the production server
database a maximum of 36 times per year by request only (The allowance of 36 database copies
per year is the total allowance across all environments). Availability for these databases and
services level objectives will be treated the same as non-production environments.
Additional Non-Production Environments
Deltek Enterprise Cloud offerings provide the ability for customers to add additional non-
production environments as an add-on to their subscription for a minimum of 1 year. These
environments can be used in any capability such as development, training, testing, configuration,
system integration, and however the customer sees fit. These environments can be refreshed
from the production server database a maximum of 36 times per year by request only (The
allowance of 36 database copies per year is the total allowance across all environments).
Availability for these databases and services level objectives will be treated the same as non-
production environments.
Production Support Environments
Deltek Enterprise Cloud provides an always-on Production Support Environment for Maconomy.
This environment is designed to be a replica of the Maconomy database, and align to the
Maconomy Production environment configuration and data. This does not include other
Enterprise Cloud products, such as Deltek Talent, Deltek CRM, or Deltek People Planner. It is
designed to be used by your team, Deltek Customer Care, and Deltek Engineering for triaging of
Maconomy issues that have been identified in Production. Access to Implementers within this
environment and underlying servers is the same as access given to Development type
environments.
Warning: The Production Support environment is not designed to be used for Performance
monitoring and is designed for access by only 1 or 2 users at a time. Production Support
environments cannot be used for any type of extension promotion or custom configuration outside
of case (incident) resolution.
Note: Any changes to custom configuration in Production will be mirrored into Production
Support within 2 business days.
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A copy of the Maconomy Production database will be provided to this Environment at its creation
and any subsequent copies should be requested by the Customer. Add-ons are available for
purchase to setup recurring database copies or to purchase additional ad-hoc copies (above the
total of 36 database copies allowed per year across all environments). If any Severity 1 or
Severity 2 issues are identified that need further investigation by our internal teams using this
environment, a database copy will be provided outside of your database copy allowance.
Preview Environments
Deltek Enterprise provides a Preview environment prior to a minor or major upgrade for testing
customer-specific extensions or configurations in a new version without a disruption of their
current test or development non-production environments. Availability for these databases and
services level objectives will be treated the same as non-production environments.
Temporary Performance Enviornments
The Temporary Performance Environment is included for Enterprise Premium Cloud Customers
and available as an add-on for Enterprise Cloud Customers. This environment is available for 2 x
2 weeks periods a year. The environment can be used to test new extensions and other custom
features as well as load testing to ensure planned changes will not deprecate performance once
deployed to Production.
Reservations of the Temporary Performance Environment must be made at least 8 weeks in
advance and reservations are not guaranteed.
The Temporary Performance Environment must be used alongside a billable services
engagement with the performance testing team using Deltek's performance testing tools. This
can be arranged through Deltek Global Services.

Disaster Recovery
Deltek conducts an annual Disaster Recovery test per offering.

Deltek provides a Disaster Recovery (DR) environment with all offerings. Typically, the disaster
recovery site is more than 250 miles away (DR250) from the production hosting facilities unless
otherwise specified.
Deltek evaluates the Disaster Recovery capabilities of our Cloud solutions annually through the
use of disaster simulations. These tests are designed to leverage environments representative of
the clients' production environments and factor in variables such as customers' database and
document size as well as regional infrastructure capacity differences. This design allows Deltek to
perform tests without impact to our clients' environment or resources.
These annual tests are a part of the overall Disaster Recovery program that Deltek uses to
evaluate the our Disaster Recovery capabilities. The program has checks during the planning,
execution, and retrospective phases to ensure we are able to evaluate the effectiveness of the
planning, processes and procedures, employee training, and other business, technical, and
operational details. This ensures that any improvements are identified and applied to future
Disaster Recovery plans.

Backup and Retention
Production Environments & Databases
Production environments and databases are backed up on a nightly, weekly, and monthly
schedule. Backups are done on the local database server and are transported to an in-region
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secure AWS S3 storage location. Production backups are retained per the schedule below in a
rolling fashion. Backups that are outside the retention window are deleted from our systems.

Type Frequency Number Retained

Full Nightly 7

Full Weekly 4

Full Monthly 1

Note for Customers with Primary Operations / Legal Entity in Denmark: For customers who
are obligated to meet the requirements of the Danish Bookkeeping Act, an additional data backup
procedure is included as part of the Deltek Cloud Service. In addition to the standard backups
(referenced in the above table) covering current year activities and can be made available to the
Danish Tax Authority upon request, a backup of each year-end (calendar or fiscal) will be taken
and stored in a secure location as a part of the Deltek Cloud Service. These annual backups will
be held for 5 years, after which, the annual backup will be permanently removed. Upon request
from the Danish Tax Authority, Deltek will provide a requested database backup in machine-
readable format, at which time, a customer will be notified that Deltek has delivered their data to
the Danish Authority.
Non-Production Environments & Databases
Non-Production environments can be used for:

■ Test
■ Configuration
■ Training
■ Development
■ Reporting

Each of these instances by nature is not a production live environment. As a result, the backup
and retention of these environments and the databases contained within are limited to the
following:

Type Frequency Number Retained

Full Nightly 2

Initial Setup and Configuration
As an administrator, you can perform several initial setup tasks, including provide implementer
access, provide access to users, configure roles and accounts, setup and modify passwords, and
configure integration to third party Identity Service Providers. View the topics below to learn about
these tasks in more detail.
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Implementer Access
You can assign your Implementer the access to the tools.

Shortly after receiving your Activation email, the Deltek Country Delivery Manager contacts you
with the details of the Deltek Consultant who will be implementing your software. You are now
ready to raise your first Service Request and request access to your Solution for the Consultant /
Implementer.
The access required for your Consultant / Implementer falls into two categories:

■ Access is required only to the Maconomy clients (Workspace Client, iAccess, Touch): As
the SaaS Administrator you are able to setup named-user accounts directly in Maconomy
through the Workspace Client.

■ Access is required to Development tools (Extensions, Report Development): This access
requires that a Service Request is raised, as shown below, to request access for named
individuals to be setup with access to your development tools.

You as the SaaS Administrator will need to assign the relevant Business Objects access to the
Implementer to be able to login to the tools. Please see the section SAP Business Objects
Access Management for further information on access provisioning within Business Objects.
Note: If an Implementer account does not connect to the Cloud within three months, the account
may be removed and a new Service Request will be required to recreate the account.
The SAAS Administrator will receive instructions on raising the Service Request in the
Welcome email sent when the SaaS order process was completed.

Grant Implementer Access

You can submit a Service Request to assign your Implementer the access to the tools.

To raise the Service Request, complete the following steps:

1. Go to https://deltek.custhelp.com.
2. Click Log In.
3. Click Cloud Solutions and select Maconomy Enterprise.
4. The Service Requests are listed in the bottom right hand corner of the screen.
5. Choose the Grant Implementer Administrator Permissions service request.
6. Enter the requested details.
7. Submit the Service Request.

Provide Access to Your Environments
You can provide the user's credentials to your employees who need to access Maconomy.

As the SaaS Administrator, during the implementation process you will receive a Welcome email
that includes information about the URLs that all employees will use to access Maconomy SaaS.
The Welcome Email also includes a link to a secure URL site from which the SaaS Administrator
and other employees can download a version installer for the Workspace Client.
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You can distribute the URLs (along with each user’s credentials) and the Workspace Client
download URL to all employees in your organization that need to access Maconomy. However,
you should ensure that all user accounts are set up in Maconomy prior to distributing the URLs.
During initial training the consulting team will instruct you on how to create your employees and
users in the system.
Note: In order for users to access the Deltek Cloud system, you will need to allow outbound
Internet access on ports 443 and 8443.

Workspace Client
The SaaS Administrator can download the Workspace Client installer via the secure URL given in
the Activation email. It is then the responsibility of the SaaS Administrator to pass the secure URL
to the relevant users within the organization.
The Workspace Client is available for both Windows and Macintosh users. Each Maconomy
release contains a TPU package, which in turn contains a WSC package containing a ZIP file, a
Windows-installable package (.MSI), and a Macintosh-installable package (.DMG).
Deltek Best Practice
Windows Installation

1. Carefully locate the ZIP file, such as:
■ Maconomy-20_0.p001e-dirmi-win32.win32.x86.zip

2. Extract this file and install the Workspace Client on the user’s machine.

Deltek Best Practice
Macintosh Installation

1. Carefully locate the DMG file, such as:
■ Maconomy-20_0.p001e-dirmi-macosx.cocoa.x86_64.dmg

2. Extract the DMG package.

3. Install the Workspace Client on the user’s desktop or in the user’s Home folder in order to
allow read/write access. This ensures that the WSC automatically updates in all
scenarios.

The connection settings for the Workspace Client are also provided in the Activation Email. These
will be entered the first time you open the Workspace Client.
Prepopulate IP Address and Port Number
When installing the Workspace Client, you can prepopulate the IP address and Port number in
the .ini file so that the end-user does not need to enter them at first login. Update Sites overwrite
the .ini file when the Client is automatically updated following an upgrade. If you would like to
prepopulate IP addresses and Port numbers for end users and would like this to be maintained
post-upgrade, you must implement a .cmd wrapper to launch the WSC, such as:
Maconomy.exe -a <hostname> -p <portnumber>

iAccess
Users of iAccess access the solution via a URL, such as https://companyname.deltekfirst.com/
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Touch Time
Users of Touch Time can download the latest version of the ‘Deltek Touch for Maconomy’ App.
For iOS this can be downloaded from the App Store and for Android it can be downloaded from
Google Play.
When first accessing the application enter the URL given in the Activation Email into the Server
URL field.

Configure Roles and Accounts
You can setup a personal account, create user accounts, and assign passwords to your
employees.

When you are given access to the Maconomy SaaS environment, the SaaS Administrator
account is already set up for you and named "SysAdmin". This is a generic admin account to get
you started. It is recommended that you setup a personal, named-user account for yourself as
you proceed through the implementation. The username will typically be your full name. The initial
username and password for the SaaS Administrator account are included in two separate emails
sent to you. You will be asked to change your password after your initial log in.
When you receive initial access, note that the database is blank. The database will be populated
with data during Implementation. We recommend that you wait until Implementation to use the
solution with the guidance of your Consultant/s.
Note: If you lose or forget your SaaS Administrator password, you must submit a service request
through Deltek Customer Care to restore access to the Administrator account.
The SaaS Administrator account includes administrative permissions that give you full access to
all areas of the Maconomy software that have been licensed to your organization. As the SaaS
Administrator, you then have the responsibility of creating user accounts and assigning
passwords to your organization’s employees.
It is recommended that SaaS Administrators be cautious in setting up further
Administrator accounts within the Maconomy database. Such accounts provide access to
all of your data and all functions and as such should only be provided sparingly.
Note: Administrator accounts within the Maconomy database will not sync with Business
Objects. Once the initial build is complete and you have received initial solution training from
your Implementer you will be able to set up user accounts in Maconomy by accessing the
relevant workspaces from the main menu in the left part of your Workspace Client.

Standard User Setup

There are standard users set up in addition to the named users to which you control as SaaS
Administrator.

These standard users are utilized as part of the overall configuration of your environment, and are
provisioned at the point of environment delivery. It is the responsibility of your system
implementer(s) to maintain the availability of these accounts during your system implementation
or migration.
Following go-live, these accounts should not be changed, and are maintained by Deltek Cloud
Operations:

■ Background Task
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This user is used by the Background Task framework to run Background Tasks. These
are tasks that have been set up in the background to run automatically (that is, without
manual intervention and according to a predetermined schedule). This account should
not be blocked at any time.

■ SysAdmin
This user is the first user we supply to the customer when we deliver a system and is
provided so that they can log in. This user can be blocked if required once the Customer
has setup their named user accounts.

■ PeoplePlanner
This user is used by the automatic process that transfers users from Maconomy to
People Planner. This process runs automatically. This account should not be blocked at
any time.

■ USync
This user is used by the USync tool. USync is a tool which creates Maconomy users in
Business Objects so that they can access reporting. This tool runs automatically each
night. This account should not be blocked at any time.

■ Other Deltek Supported Applications

The above standard users will not require a Maconomy license, and therefore not count against
your licensed user count.
Note: Please DO NOT modify these standard accounts, as it may impact the availability of your
system.

Password Policies
You can setup, modify, and implement password policies in the settings.

General Password Policy
Deltek works continuously to protect the security, privacy, and integrity of the data stored within
each customer’s SaaS instance of Maconomy.
As a result, when a new customer environment is activated, Maconomy SaaS is configured with
the following default password policies enabled as a minimum requirement:

■ Minimum Password Length: 8
■ Minimum Number of Letters: 1
■ Minimum Number of Digits: 1
■ Minimum Number of Special Characters: 1
■ Maximum Number of Character Repeats: 6
■ Validation Period in Number of Days: 90
■ Number of Passwords between Reuse: 8
■ Invalid logon attempts before user account locked: 3

While these password policies are the minimum requirement per our cloud service, it is possible
to implement more stringent policies which will be changed in to the settings. For instance, if you
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would like to enforce passwords of 10-character length rather than 8, then this is your
responsibility as SaaS Administrator.

Password Policies for Deltek Cloud AD Accounts
If any customer utilizes a Deltek Cloud AD account to log in directly as part of their cloud product
(For example, for Implementer developers in Maconomy Enterprise Cloud), then there are
specific password policies in effect to be aware of.
Passwords
Deltek Global Cloud must use secure Deltek Login credentials with strong and complex
passwords. Passwords require rotation every 60 days. Passwords are protected during
authentication and at rest by approved cryptography mechanisms. Prior to gaining access, two-
factor authentication is required for every login interface and account for any cloud service and/or
code repository.
Password Complexity
Deltek Global Cloud employs password complexity requirements as follows:

■ Passwords must be at least 15 characters in length
■ Passwords must contain at least once each of upper-case letters, lower-case letters,

numbers and special character.
■ Previous ten passwords are not allowed

Additional Recommended Password Controls
■ Passwords should not be comprised of, or otherwise utilize, words that can be found in a

dictionary
■ Passwords should not be comprised of an obvious keyboard sequence (i.e. qwerty)
■ Passwords should not include "guessable" data such as personal information about

yourself, family members, birthdays, the current month, addresses, phone numbers,
locations, etc.

Reset Password

Maconomy provides you options on how you can reset your password.

If the SaaS Administrator forgets their own password and requires it to be reset, they should use
the Password Self-Service function in Maconomy where users can reset their password. This
will authenticate via email and allow the user to change their password with the email-verified
authentication code. The email will be sent to the email address entered against your Employee
record in Maconomy. The Password Self-Service function can be accessed via the Maconomy
Workspace Client login screen, by selecting the link “Forgot your password?”
As a SaaS administrator, you can reset the password for any user in the User workspace. You
search for the relevant user using the standard search functionality in the filter and then use the
reset function when on the user’s record.
Note: A Change Password option is also available when your user is logged into Maconomy,
under the File menu at the top.
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Single Sign-On (SSO) and Multi-Factor Authentication (MFA)
As a best practice security perspective, Deltek recommends that every customer configure their
system to integrate to one of the third-party Identity Providers supported by Maconomy: Microsoft
Windows Azure Active Directory, OneLogin ,or OKTA, including the setup of multi-factor
authentication through the same vendor.

The Basics
Before the inception of more modern authentication and single sign on, Users would directly
authenticate from their Client or Clients, to the Server or Servers hosting the Applications they
wanted to access, using a username and password.
Modern authentication introduces an additional and more secure element to Client/Server
communication, with integration to a Third Party Identity Provider or IdP. IdPs offer consolidated,
cloud-based identity and access management systems that work to grant or deny access across
Applications and their interfaces.
If using an IdP, a Username and Password is no longer sent and validated directly between the
Client and Server. Instead, the Client retrieves a security token from a given and trusted IdP. This
token is then presented to the Server, which has its own trusted relationship with the IdP. The
Server uses the signing key of the IdP to check the cryptographic signature of the token to ensure
its validity before granting or denying access to the Application.

Third Party Identity Provider Support
The Maconomy Enterprise Cloud offering supports single sign-on using one of three third party
IdPs. Each provide authentication across all Maconomy Interfaces, including its User Interfaces
(Workspace Client, iAccess and Touch) and RESTful API.
The three supported third party Identity Providers are as follows:

■ Microsoft Windows Azure Active Directory
■ OneLogin
■ OKTA

Deltek has no preference for, or direct relationship with these third parties when it comes to their
IdP solutions. Customers bear complete responsibility for deciding which IdP best meets their
needs, and for setup, support and maintenance of these solutions.
Once a Third Party IdP is selected and configured for a Customer, more detailed technical
information pertaining to the integration requirements can be found in the Core Maconomy
System Admin Guide or in a specific Azure Setup Guide.

Supported Authentication Protocols
Each of these three IdPs utilize the industry standard OAuth 2.0 Open ID Connect (OIDC)
authentication protocol however, each have their own different pre-requisites and specific
configuration options, including additional features such as Active Directory (AD) Integration or
Multi-Factor Authentication (MFA).
Maconomy supports the following protocols for integrating to IdPs

■ OAuth 2.0 Open ID Connect (OIDC)
■ OAuth 2.0 JWT Bearer Tokens (supported from 2.4.5 CU13, 2.4.7 & 2.5.1 CU1)
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The Maconomy Enterprise Cloud offering does not support other authentication protocols such as
Kerberos, LDAP or SAML.

Integration to Other Deltek Products
The Maconomy Enterprise Cloud offering can include other elements integrated into the core
Maconomy solution such as Business Performance Management (BPM) and People Planner.
Maconomy uses Trusted Authentication to authenticate seamlessly between core Maconomy and
these other elements. This means that Users authenticate to Maconomy via one of its User
Interfaces, and Maconomy in turn handles authentication to the other product or products.
Direct SSO to these products is not supported.

Requesting SSO for Maconomy Enterprise Cloud
To request the activation of SSO via one of the supported IdPs, use the Activate Other Features
service request from the Deltek Support Center.
For further information on individual Service Requests, see the Related Topics section below.

Activate Other Features

This request can be used to activate additional features in your environment. To do so, please go
to the Deltek Support Center and use the "Activate Other Features" Service Request to fill in the
appropriate information.

These are the possible features that can be requested:
■ Business Objects Query as a Service
■ Google Analytics for Touch
■ Live Office
■ Single Sign-On

Ensure the following information is populated in the Service Request:
SSO Version (Azure SSO, One Login, OKTA) _________
Interfaces to Enable (Workspace Client, iAccess, Touch, All, People Planner) _________

Clients Converting to Cloud from Maconomy On-Premise
As a Customer converting from an on premise installation of Maconomy to Deltek Maconomy
Enterprise Cloud please be aware of the following restrictions:

1. The Maconomy Portal is not permitted in the Cloud. The Workspace Client, iAccess and
Touch are permitted user interfaces in Cloud.

2. The Administrator checkbox will need to be unchecked on your Administrator users.
3. BPM - Only one custom report folder is permitted in Cloud "Custom", all custom reports

must be moved to this folder.
4. A number of Cloud Admin Users will be created in your environments, these are used for

integrations and servicing your environments and should not be blocked.
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5. Any extensions using MScript will need to be rewritten in Java and committed to a Github
repository.

6. Any integrations will need to use one of the following permitted methods Integration
Methods

7. The scheduling of extension/integration tasks should utilize the background task
framework. This is available to administer in the Maconomy application. Operating
system task scheduling is not permitted.
Please contact Deltek to engage with our Consulting organization to work with you on
your move to Cloud

Configure Ask Dela
Ask Dela is an innovative, OpenAI-powered digital assistant that transforms how you interact with
the vast amount of data in your Maconomy system.

Designed to make your workflow smoother, Dela lets you query your data in natural language.
Whether you are reviewing records or searching for detailed information, Ask Dela streamlines
your access to insights, saving you time and enhancing productivity.

Enable Ask Dela
Enable Ask Dela for interactive conversations about Maconomy data.

To enable Ask Dela:

1. Go to Setup » System Setup » System Parameters.
2. Use the search filter and/or the Search field at the top of the workspace to select the

Enable Digital Assistant system parameter.
3. Select the Enable Digital Assistant checkbox.
4. Click Save.

After enabling Ask Dela at the system level, you must enable it for each user that requires access
to the digital assistant.

Set Up User Role Access for Ask Dela
System administrators can specify a security role’s access to Ask Dela.

You must first enable Ask Dela in Maconomy.

To grant access to Ask Dela:

1. Go to Access Control » Users » Actions.
2. Use the search filter and/or Search field at the top of the workspace to select a user.
3. On the Permitted Misc. Actions card, select Enable Digital Assistant.
4. Click Save.
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Set Up Super User Access to Access All Threads
Use these steps to provide a super user with access to view all user conversations with Ask Dela.
This can be useful when debugging Ask Dela. Threads created by other users can be viewed in
the Threads reference workspace. Access to view all threads should be granted with caution.

This procedure assumes that you have enabled Ask Dela and granted user role access to the
digital assistant.

To grant access to see all threads:

1. Click Access Control » Users » Actions.
2. Use the search filter and/or the Search field at the top of the workspace to select a user.
3. On the Permitted Misc. Actions card, select See All Digital Assistant Threads.
4. Click Save.

Dela Access to Maconomy Dialogs
To utilize Dela in Maconomy, the user must have access to specific Maconomy dialogs.

This includes:
■ Threads
■ Prompts

These dialogs are automatically added to the Required System Level Windows group.
Dela retrieves information about records from the following Maconomy dialogs:

■ ContactCompanys
■ ContactPersons
■ ShowEmployees
■ JobInvoiceOverview
■ JobOverview
■ Opportunities
■ API_PurchaseOrderLines
■ TimeSheets
■ TimeRegistrationDetails
■ VendorCard
■ ShowVendorInvoices
■ ShowInvoiceAllocationLines

The current version of Dela utilizes information only from the filter list of the aforementioned
dialogs.
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Note: To receive answers from Dela about the records listed above, users must have the
appropriate access to the corresponding Maconomy dialogs. Without the necessary
permissions, Dela is unable to provide the requested information.
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Maintain Your Solution
As an administrator, there are important maintenance considerations that you should be aware of.
Service requests, ad-hoc requests, and new feature requests allow you to support your
maintenance objectives in a variety of ways. It is also important to understand your solution's
maintenance schedule and the usage of update sites to ensure that your solution is always up-to-
date.

Service Requests
You can submit Service Requests or Support Cases directly from the Deltek Support Center Site.

Note: For any other Enterprise Cloud Service Requests not documented as standard, please
submit a Support Case to raise the request. Deltek will then investigate your request and respond
to it within 5 working days. The response may require additional details and investigation before
confirmation of whether or not the request can be supported and an estimated timeline is
provided.
As the SaaS Administrator for your company, you have the ability to request additional services
from Deltek.
You can submit a service request through the Deltek Support Center site. Service requests can
only be submitted by a designated SaaS Administrator. If Deltek receives a service request from
someone other than a designated SaaS Administrator, the request will be rejected. If you would
like your Implementer to raise Service Requests on your behalf please request this using the Add
Additional SaaS Administrators Service Request.
Note: The Implementer will need to provide you with a unique email address for this to be setup.
This email address will then need to be populated on the request when you submit it).
For further information on individual Service Requests please see the Related Topics section
below.

Activate Other Features
This request can be used to activate additional features in your environment. To do so, please go
to the Deltek Support Center and use the "Activate Other Features" Service Request to fill in the
appropriate information.

These are the possible features that can be requested:
■ Business Objects Query as a Service
■ Google Analytics for Touch
■ Live Office
■ Single Sign-On

Ensure the following information is populated in the Service Request:
SSO Version (Azure SSO, One Login, OKTA) _________
Interfaces to Enable (Workspace Client, iAccess, Touch, All, People Planner) _________
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Assign Access to Newly Created Access Control Groups
This request is raised to assign newly created Access Groups or Access Levels to a particular
User (so that they can assign to other users in the environment) or User Types in your
environments.

Ensure the following information is populated in the Service Request:
Access Type: __________________
Group Name or Access Level Name: ____________
Add to User, and/or User Type: ____________
Environments: ______________

Database Backup and Retention Request
Enterprise Cloud Customers can request up to 4 database backups per year.

This request is used to request that a backup be taken and retained by Deltek for a period of up
to 30 days. At this point, the backup will be deleted and no longer available.

Deploy Extensions
This request is used to deploy an extension release from either Development to Test or from Test
to Production. This option should only be chosen if the release has been thoroughly tested in its
current environment.

The Release Name is required, along with whether the Coupling Service will need to be restarted.
A Deployment Guide must be attached to this service request. A Deployment Guide template can
be downloaded from the link in the Service Request. The extensions consultant who has
designed the release in the Development environment should be able to assist you with providing
the right information in the Deployment Guide. Please ensure the following information is
populated in the Service Request text and that the Deployment Guide is attached:
Environment From: __________
Environment To: ____________
Release Branch Name: _________
Coupling Service Restart Required: Yes/No

Enable Email Alerts
If you would like a new or existing Email Alerts Distribution to be enabled in one of your
environments you should raise this request.

If you are enabling Email Alerts in a Non-Production environment for the first time please ensure
that you have engaged with Deltek Professional Services to setup a target test email address
(using system natures) for all emails to be directed to. If you are enabling Email Alerts in a
Production environment please ensure that all Employee records have correct email addresses
against them.
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Environment Data Refresh
This Service Request is used to request a refresh to one of your non-production environments.

Deltek makes a refresh based on a copy of your existing production database. This replaces your
existing non-production environment with your latest production data. Enterprise Cloud
Customers are allowed to refresh their non-production environments up to 36 times per calendar
year (36 times across all environments). If you would like to have additional ad-hoc database
copies please speak to your AM/CSM to find out more about available add-ons.
Available options when requesting a Data Refresh are:
Perform ETL Full Load
Include People Planner Copy (only applicable to Customers with People Planner in Enterprise
Cloud)
Note: A data refresh from production to Dev or Test Environments may impact extensions,
configurations, on-going testing, or other changes. Please work with your consulting/development
team before submitting a database refresh request.

Warning: Be aware that the database copy process is designed to move data from Production
to Non-production. This process completely overwrites data in the database with the data from
production. If you have extension code deployed to a non-production environment that includes
custom tables or fields not in the copied Production database, you will receive errors.

ETL Job/Transformation Promotion
Use this request if you have amendments or additions to ETL Job or Transformations that need
promoting to your Test and the Production environments.

Ensure the following information is populated in the Service Request:
Environment From: ________________
Environment To: _____________
ETL Option: ________________
Repository Name: _______________
Job/Transformation Name/s: ________________
Job Transformation location/s: ____________
Notes/Special Instructions: ___________

ETL Job/Transformation Schedule Request
Use this request if you have an ETL Job or Transformations that needs scheduling outside of the
normal schedule.

Ensure the following information is populated in the Service Request:
Environment/s: __________
Job/Transformation Name/s: ________________
Job Transformation \location/s: ____________
Schedule Frequency: ______________
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Start Date of Schedule: ______________
Time: ______________
End Date (Optional): ______________
Notes/Special Instructions: ___________

Extend Access Period for a People Planner Rich Client User
This request can only be submitted before a People Planner Rich Client's access has expired.

This is the start of your concept.
This request can only be submitted before a People Planner Rich Client's access has expired.
Ensure the following information is populated in the Service Request:
User Name:
User Email: ______________
Extend Access Until: [Calendar here]

Extend the Access period for an Implementer
This request can only be submitted before an Implementer’s access has expired.

Access can be extended for a maximum of 1 year. Ensure the following information is populated
in the Service Request:
Implementer Name:
Implementer Email: ______________
Extend Access Until: [Calendar here]

Grant Implementer Permissions
At the beginning of the implementation the SaaS Administrator will submit a Service Request to
grant the Implementer access to the Maconomy environments in order to implement the system.

Access is also granted to the Development environment to allow for data builds and extensions.
Access can be granted for a maximum of 1 year. This Service Request will also be used after Go-
Live when you require a Consultant to make changes. Implementer Access requests are typically
completed within 2 business days. Note: By providing implementer access, it does not mean the
implementer can submit customer care cases and/or service requests on the customer’s behalf; if
required, the implementer must first be designated an Authorized Support Contact.
Please include the following information in the request:
Implementer Name: ____________
Implementer Email: ____________
Access Until Date: _____________
Implementer Role: Application (Business) Consultant OR Extension/Report (Technical)
Consultant
Note: Any Implementer account that is not used (logged into) for more than 60 days is subject to
removal as part of Deltek's security policy. Accounts that are removed will need to be re-
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requested via a new Grant Implementer Access Permissions request. Note that this affects
domain developer accounts only and does not affect Maconomy or Business Objects application
accounts.
Password Complexity
Deltek Global Cloud employs password complexity requirements as follows. This is for the
implementer's AD account:

■ Passwords must be at least 15 characters in length
■ Passwords must contain at least once each of upper-case letters, lower-case letters,

numbers and special character
■ Previous ten passwords are not allowed

Additional recommended password controls include the following:
■ Passwords should not be comprised of, or otherwise utilize, words that can be found in a

dictionary
■ Passwords should not be comprised of an obvious keyboard sequence (i.e. qwerty)
■ Passwords should not include "guessable" data such as personal information about

yourself, family members, birthdays, the current month, addresses, phone numbers,
locations, etc.

Import M-Config Setup
Use this request to promote your build files.

Data Builds are used mainly during Implementation to import opening balances and Master data
ready for Go-Live. Initial builds will be done in the Development environment. This request is
used to promote the build from Development to Test and once verified from Test to Production.
The Consultant who has done the data build should be able to help you with providing the right
information. Please ensure the following information is populated in the Support Case text and
that the build files are attached to the Support Case:
Environment To: ____________
Truncate Database: Yes/No
Additional Comments: ________________________
Data Configuration Options:

■ UK System
■ US System
■ Danish System
■ Norwegian System
■ Swedish System
■ Dutch System
■ IA Credit Control
■ IA Email Alerts
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■ IA Work Order
■ IA PSO Extensions
■ IA CPA Solution
■ Accelerator Runtime Files Only
■ Import IA Demo Data

Options:
■ Load Shortname data: _________________________Export Solution Data
■ Install Portal Database Framework
■ Install Portal Components

New User for People Planner Rich Client
This request can only be used if you have purchased People Planner within your Enterprise
Cloud offering.

As part of the People Planner add-on, you receive 1 Admin license (you may also have
purchased additional admin licenses). Use this request to assign Users to those Admin licenses
and get access to the People Planner Rich Client through Citrix The majority of your users will
access People Planner through the Workspace Client. Ensure the following information is
populated in the Service Request:
First Name: ____________
Last Name: ____________
Email: ______________
Expiration Date: ____________
Is Azure SSO enabled in your Maconomy instance: ____________

Pause Recurring Database Copy
If you have purchased an add-on for a recurring database copy this request is used to pause this
schedule.

Ensure the following information is populated in the Service Request:
Environment From: ____________
Environment To: ____________
Pause Start Date: ______________
Pause End Date: ______________
Notes/Special Instructions:_____________

Promote Custom Reports / Universes
Custom reports and universes can be added to your environment as required.

This Service Request is used to request promotion of a report, a universe, or both.
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These reports and/or universes should be thoroughly tested and, once you are happy with them,
this request is used to move them from Development to Test, and then from Test to Production.
This Service Requests replaces the previous separate service requests "Promote Custom
Report" and "Promote Custom Universe".

Request Latest Cumulative Update
You can request your environments to be updated to the latest available CU level for your
version.

When you submit this request you will be advised by return of when the updates can be applied,
please note that during busy periods the scheduling may take longer and the dates offered may
be further in the future.
Cumulative updates will be applied to Development, then Test, then Production in line with the
SDLC.
If you have both Maconomy and People Planner, please advise on the service request if you
would like the latest CU to be applied to both or just Maconomy.

Run USync to sync users with Business Objects
USync runs nightly and synchronizes users between Maconomy and Business Objects as part of
the Enterprise Cloud offering.

This Service Request is for ad-hoc requests outside of the nightly schedule. This Service Request
can also be used to schedule a future ad-hoc request for USync to run. Before submitting this
request please consider if this can wait until the next nightly run. Ensure the following information
is populated in the Service Request:
Environment/s: __________
Notes/Special Instructions: __________________

SaaS Administrator Change
This request can be raised by the SaaS Administrator to authorize further SaaS Administrator
accounts.

This can be an employee within your organization or an Implementer if you would like them to
raise Service Requests on your behalf. Ensure the following information is populated in the
Service Request:
Contact Name: ____________
Contact Email: ____________
Role: ______________
The name, email address, and role of the new SaaS Administrator must be populated.
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Security Resets
This request can be used to request a reset of user access to either 2FA or Citrix.

The Security Resets service request allows you to reset certain user access, there are two
options available: 1. Reset 2FA and 2. Reset Citrix.

1. Reset 2FA - This option resets 2FA details for a particular user. This can be used to reset
a 2FA account (For example, if a user loses the device holding their 2FA app). When
selecting this option, enter the user name of the employee and which environment it
needs to be reset in.

2. Reset Citrix - This option resets Citrix connection details for a particular user. When
selecting this option, enter the username of the employee and which environment it
needs to be reset in.

Supported Ad-hoc Requests
You can access Deltek Support Center to submit Ad-hoc Requests.

In addition to Service Requests, the following requests can be submitted as Support
Cases:

ODBC User Access Requests
ODBC User access updates must be submitted as a Support Case. The ODBC Service Request
Log spreadsheet must be attached to the Support Case.

ODBC is only available to Enterprise Cloud Customers who have purchased the ODBC add-on or
Enterprise Premium Cloud Customers where ODBC is included.

Use the Template below when submitting the request:

1. Open Deltek Support Center and click Submit Case.
2. Use the following template to raise your RNT ticket:

■ Product » Maconomy – Maconomy Solutions.
■ Severity Level » S4 – General
■ Issue Type » Application
■ Summary » “FAO DCO: Updates required to ODBC user access”
■ Detail » 

“Please see attached spreadsheet containing updated user account
information for ODBC. ”

3. Attach the following spreadsheet to the case.
■ ODBC Service Request Directions & Log

4. Click Continue and then click Finish Submitting Case.
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Temporary Performance Environment Booking
The Temporary Performance Environment is available for Enterprise Premium Cloud Customers
or Enterprise Cloud Customers who have purchased the add-on. The environment can be
reserved for 2 x 2 week periods a year. Reservations must be submitted with at least 8 weeks'
notice and are not guaranteed.

Use the Template below when submitting the request:

1. Open Deltek Support Center and click Submit Case.
2. Use the following template to raise your RNT ticket:

■ Product » Maconomy – Maconomy Solutions.
■ Severity Level » S4 – General
■ Issue Type » Application
■ Summary » “FAO DCO: Reserve the Temporary Performance Environment”
■ Detail » 

“We would like to reserve the Temporary Performance Environment for a two
week period starting:
Date: DD/MM/YYYY
Time: HH:MM (timezone)
It is understood that the reservation is not confirmed until confirmed by DCO
response to this case"

3. Click Continue and then click Finish Submitting Case.

Specify From Address for Emailing BPM Scheduled Reports/
Publications
This request must be submitted as a Support Case.

Use the Template below when submitting the request:

1. Open Deltek Support Center and click Submit Case.
2. Use the following template to raise your RNT ticket:

■ Product » Maconomy – BPM (Analytix)
■ Severity Level » S4 – General
■ Issue Type » Application
■ Summary » “FAO DCO: Specify From Address for Emailing BPM Scheduled

Reports/Publications”
■ Detail » 

“We will be issuing BPM Scheduled Reports/Publications to email accounts.
The From email we would like on the emails is
<noreply@DeltekEnterprise.com>. ”
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3. Click Continue and then click Finish Submitting Case.

Request Update Log from Production for Amendment
This request must be submitted as a Support Case.

Use the Template below when submitting the request:

1. Open Deltek Support Center and click Submit Case.
2. Use the following template to raise your RNT ticket:

■ Product » Maconomy – Maconomy Solutions
■ Severity Level » S4 – General
■ Issue Type » Application
■ Summary » “FAO DCO: Request Update Log from Production for amendment”
■ Detail » 

“Please send me a copy of the current version of the Update Log from our
Production environment.
By submitting this request I confirm that a separate Support Case will be raised once
amendments have been made to the file. I will attach the updated and re-stamped
Update Log to the Support Case along with specifying the environments to which it
should be applied.”

3. Click Continue and then click Finish Submitting Case.

Add Amended Update Log to Environments
This request must be submitted as a Support Case and is not currently a Service Request in the
Deltek Support Center.

You'll need to raise a Support Case to request that the amended Update Log be re-stamped by
Deltek prior to requesting that the amended Update Log be deployed to an environment. Failure
to re-stamp the file following change and subsequent deployment to an environment will result in
user access issues to the environment.

To submit the request:

1. Open Deltek Support Center and click Submit Case.
2. Use the following template to raise your RNT ticket:

■ Product » Maconomy – Maconomy Solutions
■ Severity Level » S4 – General
■ Issue Type » Application
■ Summary » “FAO DCO: Add amended Update Log to environment/s”
■ Detail » 
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“Please find attached an amended and stamped Update Log file. This file
should be applied to the following environment/s:
Production Environments
<Environment Name Here>
Non Production Environments
<Environment Names here>
By submitting this request I confirm that the Update Log was re-stamped following
amendment. Once deployed I as SaaS Administrator will ensure that the Update Log
is tested in each environment to which it has been applied.”

3. Click Continue and then click Finish Submitting Case.

Misc. Configuration Files Installed on Server or Custom Updates
to Standard Files
(For example, time-out settings) – In the event your implementer customizes server files, either
updating existing files or requests installation of new files, this request should be sent via an
Customer Care Case to the Cloud Operations team. The information required will depend on the
customization; however, typically this would include: General Description, File Location,
Environment(s), and Details of Update. Some examples include: updates for background task
configuration, updating time-out settings, and the like. These requests will typically take up to 5
business days to fulfill.

Database Backup Request
In the event that a backup copy of a Maconomy database is needed, a request can be made by
the SaaS Administrator to have a database backup shipped to the customer. When making such
a request it is important to include the date the backup is required on or from (please see 'Backup
& Retention' section for historic backup availability). All backup database requests will be
transmitted via secure FTP. Customers are allowed 4 database backup requests annually.
Database backup requests are typically completed within 3 business days.

Setup Talent Management Integration to Maconomy
For customers who have licensed both Talent Management and Maconomy, there must be a
Customer Care Case submitted to establish the initial link between the two products. This
process must be done for each environment (i.e. Test, Development, Production, etc.). The
request should include the Talent URL (provided to SaaS Admin by Deltek upon initial
provisioning) and the Maconomy Environment (Prod, Test, etc.) to which should be setup to
integrate to one another. This setup is typically completed within 2 business days.

Change at BO Server for Session Timeout
If you need to change the standard timeout in the solution, you can submit a request via RNT.
Provide the Environment Name and the Time Out limit you'd like. The default timeout is 20
minutes.
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Increase MaxPermSize Parameter for Tomcat
If you need to increase the max parameter size for Tomcat, please submit an RNT ticket. You will
need to provide the Environment Name and the parameter (from/to) sizing that is required.

Configure SMTP Server for Scheduled Reports and Publications
If you need to schedule reports for distribution, please submit an RNT ticket. Please provide the
Environment Name, Port, and Email Server Name.

Background Task Framework Parameters
In Maconomy version 2.4.3 and forward, the system now requires two new parameters, Batch
Administrator Email and Default email, to be configured when setting up the Background Task
framework. The Batch Administrator email should ideally be a group email account to which SaaS
Administrators in your organization receive notifications. The "Default Email" is the email account
from which all email notifications are shown to be sent (for example, donotreply@company.com ).
During your implementation, Deltek must update these values as required by your organization.
Please raise a Support Case from the Deltek Support Center with the fields and how they should
be set.
The email address provided should also be whitelisted by the organization to ensure that
messages reach the SaaS Administrators. If your email provider filters or blocks emails from this
address after whitelisting, please contact your IT Department.

Danish Bookkeeping Act - Data Retention Opt-In
If customers represent a commercial enterprise, of any kind, registered in Denmark, as well as
any commercial enterprise abroad that conducts commercial activities in Denmark, you will need
to inform Deltek of your need to comply with the Danish Bookkeeping Act. Please use the support
case template below to do so.
This request must only be raised on 1 (one) occasion, to confirm that you opt-in to the DBA data
retention requirements. Upon receipt of this request, Deltek will take additional steps to ensure
the database backups for your production database adhere to the rules provided by the Danish
Business Authority. The accessibility of the DBA-related database backups will be restricted to
Deltek and the Danish Business Authority.

Use the Template below when submitting the request:

1. Open Deltek Support Center and click Submit Case.
2. Use the following template to raise your RNT ticket:

■ Product » Maconomy – Maconomy Solutions.
■ Severity Level » S4 – General
■ Issue Type » Application
■ Summary » “FAO DCO: Danish Bookkeeping Act - Data Retention Opt-In”
■ Detail » 
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""My organization would like to acknowledge that we are a commercial
enterprise whom are required to comply with the Danish Bookkeeping Act. In
doing so, we request that Deltek retain our data in conjunction with the
regulatory requirements set forth by the Danish Business Authority. We
acknowledge that, upon written request, the Danish Business Authority may
receive access to our company data as per the requirements set forth in the
Danish Bookkeeping Act."

3. Click Continue and then click Finish Submitting Case.

Service Level Objectives
You can use Deltek Service Level Objectives as guidelines as to when the requests can be
expected to be fulfilled.

Deltek Service Level Objectives are meant to be used as general guidelines for customers when
submitting a particular Service Request, as to when the customer can expect the request to be
fulfilled by Deltek. It is important to note, these are objectives, and therefore these SLOs do not
represent commitments on behalf of Deltek Cloud Operations, nor is there a guarantee available
in regards to the timeliness of service.
Deltek Cloud Operations has an objective to complete Service Requests within the timeframe
outlined in the table below.
The SLO is considered received when the Service Request is submitted in Customer Care
Connect by the customer’s SaaS Administrator, or someone authorized to do so as a SaaS
Administrator on behalf of the customer.
“Business Days” are considered to be Monday through Friday, and traditional business hours of
8AM to 6PM are subject to the time zone of the customer’s main office. For any Service Request
that Deltek expects to cause a business disruption (e.g. those requests pertaining to the
Production environment), such requests will be addressed during non-business hours of the
location in which the particular production instance resides.
In all instances where production updates/releases are made, such deployments will typically
occur during evening or weekend hours.
Anything outside of Service Request management above should be scheduled with the release
team or DCO Manager 5 days in advance if weekend coverage is necessary.

Service Request Service Level Objective Notes

Additional Environment
Setup

15 Business Days The environment setup begins
when Deltek has fully
completed the order process.

Assign Access to Newly
Created Access Control
Groups

2 Business Days For requests for multiple
users/user types you will
receive an estimate of the time
it will take to complete the
setup in response to this
request.

Enable Email Alert 2 Business Days

Environment Data Refresh 3 Business Days
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Service Request Service Level Objective Notes

ETL Job/Transformation
Promotion

3 Business Days

ETL Job/Transformation
Schedule Request

3 Business Days

Grant Implementer
Permissions

2 Business Days

Move Custom Report 2 Business Days

Move Custom Universe 2 Business Days

Move Extensions 2 Business Days

Move M-Config Setup 3 Business Days

New User for People Planner
Rich Client

2 Business Days For requests for multiple users
or user types you will receive
an estimate of the time it will
take to complete the setup in
response to this request.

Pause Recurring Database
Copy

2 Business Days

Run USync to sync users
with Business Objects

1 Business Day

Request Access Information
to InfoView

2 Business Days

SaaS Administrator Change 2 Business Days

Any other request 5 Business Days This is a minimum dependent
on the complexity of the
requirement

New Feature Requests
If you identify enhancements or new features within Maconomy Enterprise Cloud that may be
advantageous to all customers, either the SaaS Administrator or an Implementer can request a
change to be considered to the product. This change may be considered for a future release.
You can submit a new feature request in the Ideas Portal https://maconomyideas.deltek.com/ .
Enterprise New Feature Request Process
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Maintenance
This section outlines important maintenance timelines and information that you should keep in
mind as administrator for you solution.

Planned and Unplanned Maintenance
Maconomy requires periodic planned maintenance activities. In case of unplanned maintenance
or service outage, Deltek communicates the information through Customer Care.

Maintenance
The Maconomy SaaS environment will require periodic planned maintenance. Planned
Production system maintenance activities will take place during regular recurring maintenance
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windows. Regular maintenance windows occur no more frequently than every Saturday at 6:00
PM EST and typically will last no more than 6 hours. Non-production system maintenance may
occur outside of the regular maintenance window as required.
Information on planned maintenance outage durations and timing is communicated via email from
Customer Care.
Typically, communications are sent 5 days in advance for Production downtime and 3 days in
advance for Non-Production downtime. If a need arises to conduct planned maintenance outside
of these regular recurring maintenance windows or if planned maintenance is projected to create
an outage that would exceed the six hour standard, details and timing will be communicated to
the SaaS Administrator via a specific email communication.
It is the SaaS Administrator’s responsibility to communicate the maintenance times and impact to
all company employees. Deltek recommends that the SaaS Administrator ask company
employees to make the proper arrangements to schedule tasks or jobs to execute well before or
after the maintenance windows.
In the unlikely event of unplanned maintenance or a service outage, Deltek will use Knowledge
communicate details of the unplanned maintenance or service outage event to Maconomy SaaS
customers via Customer Care. In addition, if an unplanned outage or maintenance task
necessitates the need to communicate directly with SaaS customers, Deltek will facilitate that
communication via email with the SaaS Administrators.
Note: Please be aware any scheduled tasks running on one of your environments will be paused
during a maintenance window.
OS Patching
OS patching is always scheduled the weekend following the second Tuesday of the month and
will follow your maintenance window. Communications will always be sent to remind you but
please be aware of this regular and critical activity and plan around the event as needed.

Updates and Maintenance Releases
Deltek applies cumulative updates and maintenance releases to the Maconomy Enterprise Cloud
environment regularly.

Deltek will apply cumulative updates and maintenance releases to the Maconomy Enterprise
Cloud environment on a regular basis, during planned maintenance windows as described above.
Information regarding this type of maintenance activity will be shared with customers by the
Customer Care team.
In the event that a minor upgrade, cumulative update, or maintenance release has any significant
effect on functionality that could change how a customer uses Maconomy, Deltek will
communicate information regarding the change prior to the planned installation date. It is the
customer’s and/or partner’s responsibility to test any customer specific content as updates and
releases are applied.
To your benefit and in order to bring you the latest product releases with new features and
improved quality, Deltek will upgrade or update your environments once every 18 months (at a
minimum) and not a month-end, quarter-end or year-end. As an example, Deltek would typically
apply up to two Maintenance Updates within an 18 month period and up to one Upgrade within
every 24 month period. Minor and Major Upgrades will be initially installed in the Preview and
Development Environments for review before being applied to Production and then being
replicated to other Non-Production environments. Maintenance releases will be installed directly
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in the Test and Development environment and will be pushed to Production after validation by
your team.
Note: It is expected that testing will be performed by the Customer on each environment as it is
released following any maintenance update or upgrade work.

Update Sites
You can use Update Sites to automatically update Maconomy Workspace Client.

Update Sites are used to automatically update the Maconomy Workspace Client when your
Production environment is upgraded. An update is automatically applied the first time users open
their Workspace Client following an upgrade.
The Workspace Client (WSC) is available for both Windows and Macintosh users. For Windows
installations, the WSC is available in compressed packages (ZIP) or packaged into a Windows-
installable package (.MSI). For Macintosh installations, the WSC is available packaged into a
Macintosh-installable package (.DMG).

Initial Workspace Client Install

You can follow Workspace Client installation recommendations for your platform.

The TPU package contains compressed packages (ZIP), which are recommended for installation
on the Windows platform if a customer wants to control the installation in a specific way. This
option is the recommended best practice way of installing this client to ensure that new versions
of the client are downloaded and installed on user machines whenever available.
Please be aware that if the Workspace Client was installed using the MSI installer, it will not
update automatically for all upgrades. Workspace Client upgrades where the embedded Java is
changed will only update automatically if installed using the zip packages. This is due to Update
Sites requiring write access to the directory where the Client is installed.
It is recommended that installations of the Workspace Client on Macintosh platforms are
performed using the DMG package. When installing the Workspace Client, we recommend that it
is not installed in the Global Applications folder as this will only allow read-only access to the
WSC. The Workspace Client should be installed in a location that will allow read/write access.
This will ensure that the WSC will automatically update in all scenarios.
When installing the Workspace Client using zip packages, it is possible to prepopulate the IP
address and Port number in the .ini file so that they do not need to be entered by the end user at
first login. Update Sites overwrite the .ini file when the Client is updated. If you would like to
prepopulate IP addresses and Port numbers for end users and would like this to be maintained
post upgrade, we recommend that you implement a .cmd wrapper to launch the WSC. A .cmd
wrapper would have a command like this: Maconomy.exe -a <hostname> -p <portnumber> to
launch the WSC.

Update Sites in the Enterprise Cloud

You can use Update Sites to automatically update Maconomy Workspace Client.

Update Sites are going to be enabled in your Production environment and Preview environment,
where one has been provided (Preview environments are provided for major upgrades). Update
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Sites will not be enabled in your other non-production environments. For users who need access
to multiple environments (Non-Production, Preview and Production), it is recommended that one
Workspace Client is installed for Production access only and one Workspace Client for Preview
access only. These Workspace Clients will automatically update. A minimum of one other
Workspace Client should be installed for the other Non-Production environments. When Non-
Production environments are upgraded the new version of the Workspace Client should be
downloaded from the link provided by Deltek and installed manually.
When the Update Sites are enabled it may update your users Workspace Clients when they go to
login. This will only occur if users are not using the latest compatible version. An update package
will average 60-70MB per download. There is no downtime associated with this process.
Note: Automatic updates of the Workspace Client are possible on installations of the client that
have been made via the Windows ZIP packages and Macintosh .DMG method (where write
access to the directory is ensured). If this is not the case, some versions of the Workspace Client
may contain components that cannot be updated and that may require re-installation of the
Workspace Client. Some customers may also have restrictions on their computers (such as
terminal servers) that may prevent automatic updates to succeed, and that thereby require re-
installation. Windows access rights management may also prevent automatic updates to be
successful if the Workspace Client was originally installed using the MSI installer. Deltek thereby
recommends that installations of the Workspace Client on Windows platforms be performed using
the ZIP packages and on Macintosh using .DMG.

Update Sites Process

When a Production upgrade has completed or a Preview environment provided, the Workspace
Client automatically updates to the new version when a user opens the Workspace Client and
connects.

To update the Workspace Client:

1. Open the Workspace Client to start the update.
2. If you have a firewall in place, you may receive a warning message.
3. Select Domain networks and Private networks, and click Allow Access.
4. Restart the Workspace Client and continue to login.

Note: If network connection is lost during the Update process the Update Site will resume
once connection is re-established.

Special Considerations
This sections provides details on considerations that you should be aware of regarding
attachment sizes and environment time zones.

Branding

Customer Branding of any of the Maconomy User Interfaces is not permitted in the Enterprise
Cloud.
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Attachment Sizes
Your attachments are saved directly in the Maconomy database.

Scans and documents that are attached directly in the Maconomy database (For example,
Expense Receipts, or Vendor Invoice copies) are stored in the database. It is recommended that
individual files uploaded by users are not larger than 10MB. This will ensure that such
attachments do not impact the performance of the system.

Environment Time Zones
The location of the data center determines the time zone of your Maconomy server.

It is possible for your environment to be hosted in one of several data centers (for instance, EU
West (GMT) or US East (EST)). It is important to note that the location of the data center will
dictate the time zone of your Maconomy server. It is important to note if the organization is
operating multiple entities globally, only one time zone is applied for the entire solution. One
example of how this could impact your system is the transaction time stamp will be representative
of the time zone where your solution is hosted. This will particularly impact customers with
multiple geographical locations.

Background Tasks
Background tasks are only available for DFME Flex environments.
Note: You must complete required training regarding Background Tasks before being able to use
them in your environment.

Fonts
Deltek's cloud environment includes fonts provided by Microsoft as standard within the Windows
Server 2012 R2 operating system.
The following will be available in your Maconomy environment by default:

■ Times New Roman
■ Helvetica
■ Courier
■ Symbol
■ ZapfDingbats
■ AvantGarde-Book
■ Bookman
■ Helvetica-Narrow
■ NewCenturySchlbk
■ Palatino
■ Helvetica-Condensed
■ ZapfChancery-MediumItalic
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■ NotoSans
■ LastResort

Other fonts provided by Microsoft as standard within the Windows Server 2012 R2 operating
system but not listed above can be activated on request.
In addition to the standard Windows fonts, the following fonts can be installed on request:

■ IDAutomationHC39M
■ IDAutomationOCRa
■ IDAutomationOCRb
■ MICRE13B
■ DejaVu
■ MXiangHeHeiSCPro
■ KaoriGel
■ Google Noto Fonts

If you would like one or more of the additional fonts installed in your Cloud environments, please
raise a Support Case.
The fonts listed above can be installed (per request) and are pre-approved by Product
Management. Font requests outside of this list should be raised as an enhancement request for
review and approval by Deltek.

Document Archive
Throughout Maconomy, you may notice a document storage facility on various records. This
Document Archive can be used to store documents such as contracts, relevant invoice backups,
expense receipts, vendor invoices, and other documents that you would like to retrieve and view
at a later time.
Note: Deltek reserves the right to put a per-file size limit on any customer solution as deemed
necessary.

Two-Factor Authentication (2FA)
To set up two-factor authentication (2FA) in Maconomy:

1. Download and install a 2FA application on your mobile phone. Some popular options for
this are Google Authenticator or Duo Mobile.

2. Log in to Maconomy.
A QR code is generated upon login.

3. Using the 2FA application installed on your mobile device, click the Add button to scan
the QR code generated in Maconomy.

4. Enter the six-digit code generated in the 2FA app in the box captioned Enter one-time
passcode in Maconomy, and then click Login.
After initial setup of 2FA, you will be required to enter a 2FA code upon login to
Maconomy.
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Extend Your Solution
As an administrator, there are several ways in which you can configure and extend the
functionality of your solution.

Extensions, integrations, and Citrix-based development tools allow you to take existing Enterprise
cloud functionality and customize it to the unique needs of your organization.

Important: In order to be DMARC compliant, any extensions that send an automated email
from Maconomy must use the email address noreply@deltekenterprise.com in their From email
field. If this is not done, emails that are sent will potentially fail

Extensions
The Deltek Maconomy Cloud SDLC Guide contains information on implementing extensions to
the Deltek Maconomy Enterprise offering. Please download this document from the Support
Center and read it carefully to understand your responsibilities in the development process.

Integrations
You can do the standard file-based integration and other integration capabilities approved by
Deltek.

The preferred integration method for all Deltek Cloud Solutions is through the Maconomy API. In
cases where the API cannot handle the volume or scenario, each solution has standard file-
based integrations or has the capability for customers and services to build their own file-based
integration. In those scenarios, the following protocols are supported for transport of files to a
place that the application can operate on files:

■ Primary Method: The customer provides Deltek with access to an Amazon Web Services
S3 location where the customer places files for Deltek to pull into the Deltek AWS
infrastructure.

■ Secondary Method: The customer provides Deltek with access to a customer maintained
secure FTP (S-FTP) site where Deltek can pull files from the customer into the Deltek
AWS infrastructure.

Deltek currently does not support customers pushing files into the Deltek AWS infrastructure for
security reasons. In order to ensure customers are protected, pulling files into a guaranteed
location where they can be scanned and assessed from a security perspective is the supported
approach. Customers or their consulting advocates are not allowed to circumvent the supported
methods above by creating extensions that would allow for files to directly be imported into the
Deltek Cloud for any applications.
Deltek currently does not support a direct connection for pulling or pushing files to a 3rd party
vendor that Deltek is not contracted to directly. The supported method in this scenario is to have
the customer interface with third parties and then provide a secure location, as mentioned above.
The following integration capabilities are available with the Enterprise Cloud standard offering:

■ Maconomy RESTful API *recommended approach
■ SOAP
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■ Standard Maconomy Import Programs
■ Business Objects Query as a Web Service
■ ODBC read-only access (add-on required)

Other integration capabilities may be available based on Deltek review and approval of detailed
technical requirements.
Examples include:

■ File-based integrations
■ Secure FTP, Deltek push/pull; direct from the customer
■ S3 Bucket (customer-owned); Deltek push/pull

Examples of integration types NOT supported:
■ ODBC write or update
■ Direct SQL bulk data loads
■ Secure FTP from 3rd party; Customer push/pull

Warning: If you have any planned integrations which use any method not mentioned in this
section, a Design Document must be submitted to the Deltek Cloud team for approval. Design
Documents can be submitted using a Support Case with Subject “Integration Design Document
for DCO Review.”

The Design Document must contain the following information:
■ Name of integration.
■ How is it installed and configured.
■ Exactly what is installed e.g. a list of files, what executables, etc.
■ What communication protocols are required e.g. outbound https/443.
■ Any additional information that may be useful to know.

Security Assessment
Extensions and integrations go through a security review process to ensure that customer-
specific content are developed securely.

In order to avoid introducing a security vulnerability into the Cloud environment code must be
written in a secure manner. Ensuring that customer-specific content is developed in a secure
manner is the Customer’s responsibility.
In an attempt to mitigate custom code which is not written in a secure manner, all extensions and
integrations must go through a security review process. The Security Questionnaire should be
filled out by the developer(s) and submitted via email to DCOMacEntSecurityReview@deltek.com
for DCO to review. Once the questionnaire has been received, the security team will reach out to
the developer(s) within 3 business days to schedule a review meeting.
Deltek has the right to mitigate this risk at Deltek’s discretion, by providing periodic code scanning
of custom extensions after they have been deployed. If vulnerabilities are identified by Deltek,
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they will be reported back to the Customer who is responsible for making the appropriate code
corrections.
Note: Extensions should be written as Java Extensions. Although extensions written in MScript
are allowed in the Enterprise Cloud, any MScript extensions will not be subjected to Security
scanning and are therefore allowed at the Customer’s own risk. The responsibility of ensuring
that MScript does not introduce any security vulnerabilities sits with the Customer and is not the
responsibility of Deltek.

Accessing Development Tools
You can access the Development Tools through Citrix.

Access to the Development Tools is provided through Citrix. The following development tools are
available:

■ Web Intelligence Rich Client
■ Information Design Tool (IDT)
■ SQL Server Management Tool
■ Lumira
■ Query as a Web Service Designer*

*This application is not enabled as default. Please request this to be enabled via Support
Case

Citrix Access
You can submit a service request in Deltek Support Center to gain access to Citrix.
Access details for Citrix are obtained by submitting a Grant Implementer Access Permissions
service request in the Deltek Support Center. This request should be submitted for the SaaS
Administrator and any other users who will need access to one of the Development Tools listed
below. When choosing options within the request, be sure to select Extension/Report (Technical)
Consultant.
Note: Citrix access expires after 12 months. SaaS Administrators can re-establish access by
again raising the "Grant Implementer Access Permissions" Service Request.

Connecting to Citrix
Once you have received your access details, you must follow the following steps to access the
Citrix server and from there access the Developer Tools.
Citrix is required to access some applications in the development environment
To install the Citrix Receiver plug-in, complete the following steps:

1. Go to the Citrix URL. This was provided in the information sent to the Implementer when
their account was set up. Please look back at the email you received when your account
was activated for this information.

2. Enter your DCOFLEXPLUS user account (just the username) and password (provided by
Deltek in two separate emails).
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3. If prompted, click Detect Receiver. If the receiver isn't detected, review the license
agreement. If you agree, mark the checkbox to accept the license agreement and click
Download.

4. Click Continue on the original web page and Launch Application if prompted. The Citrix
StoreFront is presented.

5. Click APPS at the top of the page. The applications available to you are shown.

6. Click on an application to launch it.

Resetting Your Citrix Password
Your Citrix password can be changed when you are logged into Citrix. There must be at least 24
hours between password changes. To change your password, click on your name in the top
corner and choose Change Password. Passwords must have a minimum of 8 characters and
consist of 1 lowercase letter, 1 uppercase letter, 1 number, and 1 special character.

SQL Server Management Studio
Your current Implementer users will have Read-Write access to Development Type environments
and Read-only access to Test Type environments (where applicable) using the SQL Server
Management Studio. Access to SQL Server Management Studio will be provided in Citrix. Note:
Read-Only access to Test Type environments is only available to Enterprise Cloud Customers
with 5000+ current users.

To access SQL Server Management Studio:
■ From Citrix, click on the SQL Management Studio icon to launch.

1. On the logon page add the server name of the server you wish to access into the
Server name field.

2. Enter your FLEXPLUS account User name and Password and click Connect.

Query as a Web Service Designer
The Query as a Web Service Designer tool can be made available on request. To request this
please raise a Support Case using the template below. Deltek will respond within two business
days to advise of when this will be enabled. This feature requires downtime to be enabled and will
typically be done over a weekend.

To submit a Support Case:

1. Open Deltek Support Center and click on Submit Case
2. Use the following template to raise your RNT ticket:

■ Product » Maconomy – Maconomy Solutions
■ Severity Level » S4 – General
■ Issue Type » Application
■ Summary » “FAO DCO: “Enable Business Objects Query as a Web Service”
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■ Detail » 
“Please enable Business Objects Query as a Web Service in the following
environments:
Environment Name/s:___________"

3. Click Continue and then click Finish Submitting Case.

Query as a Web Service Designer Access

The Query as a Web Service Designer tool, once enabled, is accessed through Citrix.

To access the Query as a Web Service Designer tool:

1. From Citrix, click the Query as a Web Service Designer icon to launch the tool.
2. On the logon page, add the host and system names you wish to access, along with your

BI username and password.
3. Click OK.

Lumira
If you have licensed Maconomy Analysis, you can access the Lumira Client through the Citrix
Receiver.

Lumira Client Access

To access the Lumira Client once connected to Citrix:

1. From Citrix, click on the Lumira icon to launch the Lumira Client.
2. To connect Lumira to the Business Intelligence, server click on the SAP BI Platform icon:

Enter your BI login details:
■ In the first box, enter the server URL for the Business Intelligence development

server. The URL should be suffixed with /biprws
■ Enter your BI User Name and Password

Note: The SysAdmin will receive their login details in the Welcome Email. All subsequent
users should get their login details from the SysAdmin.

3. The standard Maconomy universes provided with your Maconomy installation need to be
downloaded to your Lumira Client.
Note: This step only needs to be followed the first time a User accesses Lumira.

a) Go to File » Extensions

b) Click the download icon next to SAP Universe Query Panel.

c) Once the universe query panel has downloaded, you will need to exit and reopen the
Lumira Client.
When reopening the Client repeat Step 2.
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4. In order to find and use universes to create Lumira stories follow these steps:

a) Click New Document on the main screen.

b) Choose SAP Universe Query Panel from the Add new dataset dialog and click
Next.

c) You will be presented with a logon screen. Enter the same login details as in Step 2.
Click Next.

d) You are now able to choose from the available universes in the Reporting folder.

Enterprise Cloud Add-Ons
You can purchase add-ons to enhance your offering.

There are a number of add-ons that can be purchased to augment and enhance your Enterprise
Cloud offering. If you would like to purchase any of the items listed below please contact your
Customer Success Manager or Account Manager.

Maconomy Analytics Bundle
The Maconomy Analytics bundle includes the following components:

■ Pentaho ETL
■ Data warehouse
■ BO Features

■ Lumira
■ Dashboards

Additional Environments
You can purchase additional Development Type or Test Type environments.

It is possible to purchase additional Non-Production Environments to augment your Enterprise
Cloud offering. These environments can be either Development Type or Test Type environments
based on your organizations need.

Ad-hoc Database Copies
You can purchase additional bundles of ad-hoc database copies.

Within the Enterprise Cloud offering we allow for 36 database copies from one environment to
another per calendar year. The database copies are from Production to a non-production
environment. If you would like to purchase more ad-hoc copies than the 36 provided as standard,
the Ad-hoc Database Copies add-on allows for additional bundles of ad-hoc database copies to
be purchased. Available bundles are of either 10 or 25 database copies.
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Recurring Database Copies
You can purchase a recurring database copies add-on that you can set up from one environment
to another.

You may want to set up recurring database copies from one environment to another. For
example, you may want to have weekly copies from Production to Production Support so that
Production Support is always a recent replica of Production. If you would like to set up recurring
database copies, you can purchase a recurring database copies add-on. The available options
are Daily, Weekly or Monthly.
Note: Recurring Database Copies will apply a recent copy (within 24 hours) of your Production
database to a chosen Non-Production database. This add-on cannot be used to re-apply older
standing copies of the Production Database to a Non-Production database. If you would like to
preserve User Access Rights in the Non-Production system and not have them reflect Production,
please speak to Deltek Professional Services about engaging them to set up a Background Tasks
for this protected by System Natures.
DB Copies will be scheduled to run outside of main office business hours. For example, if you
request a database copy on the 10th March, the copy will commence after business hours on the
10th March and will complete before business hours start on the 11th March.
Note: As part of the database copy process any active connections to the database where the
copy is being applied will be terminated.
Once a Recurring Database Copies add-on is purchased, you will need to notify the Deltek Cloud
Ops team that you are ready for the recurring copies to be set up. Please be advised that there is
a lead time of 3 business days for any schedule to be set up.
You can submit your request as a Support Case in the Deltek Support Center using the template
below:

■ Create a Scheduled Recurring Database Copy

1. Open Deltek Support Center and click on Submit Case

2. Use the following template to raise your RNT ticket:
■ Product » Maconomy – Maconomy Solutions
■ Severity Level » S4 – General
■ Issue Type » Technical
■ Summary » “FAO DCO: Create a Scheduled Recurring Database Copy”
■ Detail » 

“We have purchased an add-on for Recurring Database Copies in the
Enterprise Cloud. Please activate the scheduled copies using the following
information:
Frequency Purchased: Daily/Weekly/Monthly (delete as appropriate)
Start Date of Schedule: DD/MM/YYYY
Non-Production Environment where Database Copy should be applied:
_________

3. Click Continue and then click Finish Submitting Case.
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Recurring Database Copies can be paused as required. In order to pause a recurring database
copy you will need to raise the Pause Database Copy service request. Details of this Service
Request can be found in the Service Requests section.
Note: The binary documents table will not be included in the database copy as standard. This will
ensure that the DB copy is a manageable size. To request that a specific copy include the binary
documents table please raise a Support Case through the Deltek Support Center to request this.

People Planner
You can purchase People Planner as an add-on.

People Planner is an add-on that is available to be purchased in the Enterprise Cloud. An
instance of People Planner will be setup and connected to your Maconomy environment. Once
the add-on has been purchased please see the People Planner section for instructions on setting
up User Accounts.

People Planner Interfaces

You can use different People Planner interfaces.

There are a number of user interfaces available for users of People Planner:

1. People Planner Rich Client
The People Planner Rich Client is intended for heavyweight People Planner users.
(Example: Resource Managers).

2. People Planner Maconomy Workspace Client Components
The People Planner Maconomy Workspace Client Components are access points within
the Workspace Client and are intended for lighter weight users.
(Example: Project Managers on both light and heavyweight Projects).

3. People Planner MyPlan Workspace Client Component
The MyPlan web application should be accessed from within the Workspace Client. It is
intended for employees who need a view of the assignments they have been given in
People Planner.

Workspace Client Components or MyPlan Access

You can run a master data import to import user records from Maconomy.

Users are typically imported from Maconomy as part of the scheduled master data import.
When creating users in Maconomy, the following fields in the User record should be populated:

■ Use for People Planner should be ticked
■ Login Name

Once the user is setup and has been added to People Planner by means of the master data
import (either auto run on schedule or manually triggered if appropriate), they will be able to see
the People Planner components in the Workspace Client and access MyPlan.
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Rich Client Access without Azure SSO

This section is relevant if you are not using Azure SSO. You can submit a Support Case to gain
user access to the People Planner Rich Client though Citrix Storefront.

If you have Azure SSO Setup in Maconomy, please refer to Rich Client Access with
Standard Azure SSO.

Citrix Storefront Access

Heavyweight users of People Planner require access to the People Planner Rich Client. The
People Planner Rich Client is accessed through a Citrix Storefront. To get access to the Citrix
Storefront for a user, a Service Request must be raised. Currently, this must be requested by
means of a Support Case.

To submit a case, complete the following steps:

1. Open Customer Care Connect and click Submit Case.
2. Use the following template to create your RNT ticket:

1. Product » Maconomy – People Planner

2. Severity Level » S4 – General

3. Issue Type » Technical

4. Summary » “FAO DCO: New Enterprise Cloud User for People Planner”

5. Detail » 
“Please set up the following user with Citrix access so that they can access the
People Planner Rich Client. I confirm that the User Account has been set
correctly in Maconomy to support this request.
First Name: Insert First Name here
Last Name: Insert Last Name here
Email: Insert User email address here”
Expiration Date: Insert expiration date (if known)

3. Click Continue, and then click Finish Submitting Case.
Note: The Service Level Objective for individual user setup is 2 business days. For large
volume requests, this will increase and DCO will advise when the Service Request is
received.

User Creation in People Planner

Typically, users are imported from Maconomy to People Planner as part of the scheduled master
data import.

When creating users in Maconomy, the following fields in the User record should be populated:
■ Use for People Planner should be ticked
■ Network Username:
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Name: This should be the same as the Login Name used for Citrix storefront.
Domain Name: This is your Customer Domain
Note: All users in People Planner must have Domain Alias set as DELTEKFLEXPLUS.
This must be set up in the Task Specification within the Import Master Data and Import
Users tasks. Please engage with your Consulting team if you require assistance to set
this up.

Once the user is setup and has been added to People Planner by means of the master data
import (either auto run on schedule or manually triggered if appropriate), they will be able to
access People Planner through the Citrix storefront.

Connecting to Citrix Storefront

These steps must be followed to access the Citrix Storefront, and from there access People
Planner.

To install the Citrix Storefront plug-in, complete the following steps:

1. In the response to the New Enterprise Cloud User for People Planner, you will receive
a link to download the Citrix Plugin. Open this link.

2. Enter your DCOFLEXPLUS user account (just the username) and password (provided by
Deltek in two separate emails).

3. If prompted, click Detect Receiver. If the receiver isn't detected, review the license
agreement. If you agree, mark the checkbox to accept the license agreement and click
Download.
Note: 'CitrixReceiverWeb.exe' should be downloaded to your PC. Run it once
downloaded. If you agree, accept the license agreement and install.

4. Once installed, click Continue on the original web page, and Launch Application if
prompted. The Citrix StoreFront should be presented.

5. Click APPS at the top of the page. The People Planner rich Client should be shown. Click
on the application to launch it. If the steps for creating the User in Maconomy were
followed correctly, the logon to People Planner should happen automatically.
Note: Citrix passwords expire every 90 days. Citrix passwords can be changed when you
are logged into Citrix. To do this, click on your name in the top corner and choose
Change Password. Passwords must have a minimum of 8 characters and consist of 1
lowercase letter, 1 uppercase letter, 1 number and 1 special character.

Rich Client Access with Standard Azure SSO

You can enable Azure SSO into Maconomy and People Planner. Where Azure SSO to
Maconomy and People Planner is enabled, users are required to login to Citrix Storefront using
their DELTEKFLEXPLUS account login. Once they access the Citrix Storefront, they use their
Azure login details to connect to People Planner.
Please coordinate with your Consulting team to activate Azure SSO into Maconomy and into
People Planner.
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Warning: SSO for Business Objects interfaces is not supported. Silent Sign In can be activated
for any individual reports that are embedded.

Note: As an alternative, OKTA is another method that can be used for SSO for Maconomy
interfaces.

Citrix Storefront Access

Heavyweight users of People Planner require access to the People Planner Rich Client. The
People Planner Rich Client is accessed through a Citrix Storefront. To get access to the Citrix
Storefront for a user, a Service Request must be raised. Currently, this must be requested by
means of a Support Case.

To submit a Support Case, complete the following steps:

1. Open Customer Care Connect and click Submit Case.
2. Use the following template to create your RNT ticket:

1. Product » Maconomy – People Planner

2. Severity Level » S4 – General

3. Issue Type » Technical

4. Summary » “FAO DCO: New Enterprise Cloud User for People Planner”

5. Detail » 
“Please set up the following user with Citrix access so that they can access the
People Planner Rich Client. Please note that Azure SSO is enabled and as such
the domain login name of the user is included below (for addition to the Deltek
Active Directory). I confirm that the User Account has been set correctly in
Maconomy to support this request.
First Name: Insert First Name here
Last Name: Insert Last Name here
Email: Insert User email address here
Expiration Date: Insert expiration date (if known)”

3. Click Continue, and then click Finish Submitting Case.
Note: The Service Level Objective for individual user setup is 2 business days. For large
volume requests, this will increase and DCO will advise when the Service Request is
received.

User Creation in People Planner

Typically users will be imported from Maconomy to People Planner as part of the scheduled
master data import.

When creating users in Maconomy, the following fields in the User record should be populated:
■ Use for People Planner should be ticked
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■ Network Username (enter the below in CAPS):
Name: This should be the same as the user’s login name for your domain.
Domain Name: This is your Customer Domain
Note: All users in People Planner must have Network Domain Alias set as
DELTEKFLEXPLUS. This must be set up in the Task Specification within the Import
Master Data and Import Users tasks. Please engage with your Consulting team if you
require assistance to set this up.

Connecting to Citrix Storefront

These steps must be followed to access the Citrix Storefront, and from there access People
Planner:

To install the Citrix Storefront plug-in, complete the following steps:

1. In the response to the New Enterprise Cloud User for People Planner, you will receive
a link to download the Citrix Plugin. Open this link.

2. Enter your DCOFLEXPLUS user account (just the username) and password (provided by
Deltek in two separate emails).

3. If prompted, click Detect Receiver. If the receiver isn't detected, review the license
agreement. If you agree, mark the checkbox to accept the license agreement and click
Download.
Note: 'CitrixReceiverWeb.exe' should be downloaded to your PC. Run it once
downloaded. If you agree, accept the license agreement and install.

4. Once installed, click Continue on the original web page, and Launch Application if
prompted. The Citrix StoreFront should be presented.

5. Click APPS at the top of the page. The People Planner rich Client should be shown. Click
on the application to launch it. Enter your Azure SSO login details in the People Planner
login screen.
Note: Citrix passwords expire every 90 days. Citrix passwords can be changed when you
are logged into Citrix. To do this click on your name in the top corner and choose Change
Password. Passwords must have a minimum of 8 characters and consist of 1 lowercase
letter, 1 uppercase letter, 1 number and 1 special character.

Exporting Data to Excel in the Rich Client

Gantt chart data can be exported to Excel from the People Planner Rich Client. No access is
provided to Excel in the Citrix Storefront and as such the exports must be saved to the Users
local machine. If a user attempts to export to Excel directly on the Citrix Storefront, a message is
shown.

When exporting to Excel from the People Planner Rich Client, the following process must
be followed:

1. To export Gantt Chart data to Excel from People Planner, click Export Gantt chart data
to Excel when the Gantt chart is open.
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2. Confirm the date range for your export and click Export.
3. People Planner will ask for the export location. Select Permit all access to allow access

to your local PC drives.
4. Select a location on your local machine where you want to save the file.
5. Once the export process completes, People Planner will ask if the file should be opened.

Select No and you will be returned to the People Planner Rich Client.
6. Assuming Excel is installed on your local machine, the file can be located and opened

away from the Citrix Storefront.

ODBC Read-only Access
Enterprise Premium Cloud Customers have ODBC read-only access included in their
Subscription. For Enterprise Cloud Customers ODBC Read-Only access is available to purchase
as an add-on. Read-Only ODBC Access when purchased through the add-on is provided with 5
users.
ODBC Access is provided through a 3rd party solution, hybrid data pipeline.
For details on the related ODBC Service Request, see the MS Excel file below:
ODBC Service Request Directions & Log

ODBC Add-On Activation Information

If your organization subscribes to the Deltek Enterprise Cloud, you can establish a secure, read-
only connection to your transaction database, or your data warehouse using ODBC. You can
connect tools such as Microsoft Excel, Microsoft Access directly to your database. ODBC read-
only access is available for your Production and Non-Production environments.
Note: Any issues with connectivity should be raised through a Support Case in the Deltek Support
Center. Deltek will then provide assistance as needed. Note that Deltek will provide support with
connectivity issues but the reports and extracts that are produced are the responsibility of the
customer or developer.

Manage ODBC Accounts

Before you can use the ODBC connection, you need to request the accounts you need for ODBC
access. Support Cases can be submitted through the Deltek Support Center to enable, edit, and
disable ODBC accounts. ODBC Accounts can be setup as named-users (preferred) or generic
(For example: for services, ETL, integrations) user accounts. One account will be provisioned per
email provided (either individual email, or a company 'group' email). Each account will be given
access to the relevant databases requested in the Support Case. For further information on
ODBC restrictions, account management, and such, please refer to the MS Excel file below:
ODBC Service Request Directions & Log

Enable or Modify an ODBC User Account

To enable or modify an ODBC user account:

1. Log into the Deltek Support Center.
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2. Click Submit Case.
■ Use the following template to raise your Support Case:

a) Product > Maconomy - Maconomy Solutions

b) Severity Level > S4 - General

c) Issue Type > Technical

d) Summary > FAO DCO: Enable/Modify ODBC User

e) Detail > "We have purchased an add-on for an ODBC connection. Please see
attachment for account provisioning request."
Use associated Excel spreadsheet to provide email addresses and access details for
the users you would like provisioned/changed. If a single user requires access to
more than one data source and product use a separate row for each combination.

f) Click Continue and then click Finish Submitting Case.

You will receive a response from Deltek Customer Care within 2 business days
confirming the setup. The ODBC account email address on record (individual or company
'group' email) will receive two separate emails. One email will include user name, Data
Source Name and Service URL. A second email will contain their password.

Disable an ODBC User Account

To disable an ODBC user account:

1. Log into the Deltek Support Center.
2. Click Submit Case.

■ Use the following template to raise your Support Case:

a) Product > Maconomy - Maconomy Solutions

b) Severity Level > S4 - General

c) Issue Type > Technical

d) Summary > FAO DCO: Edit ODBC User

e) Detail > "Please disable the following user's ODBC access: User or Group email
address: person@company.com"

f) Click Continue and then click Finish Submitting Case.

You will receive a response from Deltek Customer Care within 3 business days
confirming that the user account has been disabled.

Install and Configure the ODBC Driver

You must install and configure a driver on every workstation that will be used to connect to a
database.

The user who installs the ODBC drivers must have local administrator privileges (at a minimum).
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To install and configure the driver:

1. Download the appropriate driver installer from the following links:
■ HDP ODBC Driver
■ HDP JDBC Driver
■ HDP Linux Driver

2. Extract all the files in the downloaded ZIP file to a folder on your computer.
3. From the folder downloaded in Step 2, run the executable for the architecture that

matches the tool with which you will be connecting via ODBC (For example, if you are
running 32 Bit Microsoft Excel, install the 32 Bit ODBC driver).

4. Follow the prompts:

a) Install Type - choose Standard Installation.

b) Install Directory - we recommend file path C:\Program Files\Progress\DataDirect
\Hybrid_Data_Pipeline_for_ODBC_4_6.

c) Create Default Data Source - Leave the Create Default Data Source checkbox
unchecked.

d) Pre-Installation Summary - Click on Install.
5. Execute the ODBC Administrator.
6. From the ODBC Data Source Administrator dialog box, you can create either a User DSN

or System DSN. User DSNs are for a single user; System DSNs are available to all users
of the workstation. Select the User DSN or System DSN tab, based on your needs.

7. Click Add. In the Create New Data Source dialog box, select DataDirect HDP 4.6 and
click Finish.

8. In the ODBC Cloud Driver Setup dialog box, enter a name in the Data Source Name
field. This can be any name that helps you identify the data source.
You do not need to add a value in the Description field.

9. In the Hybrid Data Pipeline Source field, enter the Data Source name and the Service
URL that you received from Deltek Customer Care when you requested the ODBC
accounts.
The Port Number field should be left to the default value of 443. If connecting to multiple
product databases, you will need a separate DSN for each connection.

10. On the Security tab, ensure that the Enable SSL checkbox is selected.
11. Click Test Connect and enter the credentials that you received from Deltek Customer

Care when your ODBC account was set up. Click OK.
A Connection established! message displays. Click OK.

12. Click Apply to save the configuration, then click OK and click OK in the ODBC Data
Source Administrator dialog box.
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Connect to Your Database

Once the ODBC driver is installed and configured, you can make a connection between the
workstation and the database, using any application that supports ODBC connectivity.

Warning: ODBC queries are the customer's responsibility. It is possible that a poorly written
query could have a negative impact on performance. This is not Deltek's responsibility, and the
user who owns the ODBC active account must not overlook this.

To connect to the database:

1. Go to the application from which you want to connect to the database and initiate an
ODBC connection.

2. Select the data source that you entered in the Data Source field in Step 6 of the Install
and Configure instructions.

3. Enter your credentials for the database connection.
4. Build a query (using the Query Wizard in Office).
5. Execute the query.

Project Environment Bundle
The Project Environment Bundle is an add-on that provides 3 additional environments to support
ongoing projects. The environments provided are:

■ Project Development
■ Project Data Migration
■ Project UAT

This add-on can be purchased for a period of either 6 or 12 months. Multiple bundles can be
purchased if required.
Enterprise Premium Cloud Customers have one Project Environment Bundle included with their
subscription.

Temporary Performance Environment
Deltek can provide access to a temporary performance environment for the purposes of testing
your systems under load. A typical example of usage would be testing a new Extension before
deploying it to Production to ensure it does not degrade performance.
When the Temporary Performance Environment is purchased, the environment can be reserved
for 2 x 2 week periods per year.
The environment must be reserved a minimum of 8 weeks in advance and reservations are not
guaranteed.
The Temporary Performance Environment must be used alongside a billable services
engagement with the performance testing team using Deltek's performance testing tools. This
can be arranged through Deltek Global Services.
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The Temporary Performance Environment is included for Enterprise Premium Cloud Customers
and is available as an add-on for Enterprise Cloud Customers.
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Reporting
As an administrator, you have a variety of reporting options. You can use SAP Business Objects
and Analyzer in Maconomy to view both standard and custom reports for your organization..

SAP Business Objects Reporting
You can use certain SAP Business Object features in your cloud environments.

As part of the Enterprise Cloud offering, there are certain SAP Business Objects capabilities that
will be available in particular cloud environments.
All Enterprise Cloud environments will include the following BO features:

■ BI Launchpad – utilized to develop and distribute reports
■ Central Management Console
■ Live Office
■ Scheduling
■ Publishing
■ User management
■ Access management
■ BO Auditing - allows customers to report on events performed by Users in Business

Objects.
Click here for detailed information on the configuration of BO Auditing in the Maconomy
Enterprise Cloud.

Additionally, for Development Environments, the following BO features will also be available:
■ Web Intelligence Rich Client
■ Information Design Tool (IDT)
■ Promotion Manager
■ Visual Differences
■ Upgrade Management
■ Translation Management

If you have licensed Maconomy Analysis, then you will also have access to the following tool in
the Development Environments:

■ Lumira

Warning: Deltek reserves the right to terminate any long running reporting queries to ensure
your environments are protected. Deltek will terminate any queries that run for 60 minutes or
longer and will notify the Customer of such terminations through Customer Care

From Business Objects version 4.2 SP5 a (GDPR) data protection popup message has
been introduced.The message reads: "The product contains open or freely configurable entry
fields, which are not intended for storing personal data without additional technical and
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organizational measures to safeguard data protection and privacy." End users can silence this
message by selecting “Do not show this message again”.

Note: All Cloud Customers will be updated from Business Objects 4.2 to Business Objects 4.3
in 2024. This update will ensure continued support of the Business Objects solution as well as
providing you with a more modern interface and additional functionality for report writers. The
Live Office tool will be deprecated with the update to Business Objects 4.3. Deprecation means
the feature will still be available throughout the BO 4.3 release. However, no new
enhancements are planned for this feature, and new Platform & Data source support will be
very limited.

Recommended Access Roles for Business Objects
You can setup Business Objects access roles using this guide.

As part of the Enterprise Cloud offering, the SysAdmin Business Objects (BO) role is set up as
default. The SysAdmin role is assigned to the customer’s SaaS Administrator. The SaaS
Administrator is responsible for distributing access to additional users by creating new roles of
equal or lesser access to the SysAdmin role.
Groups and users are synchronized between Maconomy and Business Objects. This is handled
by the USync tool that is scheduled to run automatically every night. Creation and deletion of /
groups in Business Objects takes place within Maconomy. All standard roles are maintained as
groups in Maconomy. USync will run each evening to synchronize Maconomy with BO. If you
require the synchronization to happen earlier please raise the Run USync to sync users with
Business Objects service request in the Deltek Support Center.
Note: Creating or deleting groups must take place in Maconomy. Users must be assigned to their
BO role by assigning them to the relevant Maconomy group. Removal of users from Business
Objects role is done by removing the user from the relevant group.
The following roles are provided as standard in the Enterprise Cloud Business Objects solution:

■ SysAdmin
■ The SysAdmin role gives full access to all functions in the Business Objects solution

to administrate content, users, and applications. This includes folders, inboxes,
categories, universes, calendars, and events. The SysAdmin cannot modify the
Administrator user as this role is only accessible by Deltek Cloud Operations. The
SysAdmin does not have access to any server management as Deltek Cloud
Operations handles this. This includes servers, server groups, replication lists,
federation, and the multitenancy management tool. Connections as also controlled by
Deltek Cloud Operations, but SysAdmins and all other roles have read access to
these.

■ The SysAdmin has full control over content in the customers Development
environment. This includes access to necessary development tools such as the
Information Design Tool, the Upgrade Management Tool, and Promotion
Management. These tools are not available in Test and Production environments,
where Deltek Cloud Operations controls all content. Content is promoted from
Development to Test and then to Production by Deltek Cloud Operations.
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All non-administrator Maconomy users are automatically transferred into BO every evening via
USync. USync synchronizes and creates usernames in Business Objects per the setup in
Maconomy provided by the SaaS Administrator. The new users are all created with a secure
(unknown) password. Maconomy groups are also transferred to BO and assigned to the relevant
users.
If a user requires direct access to the SAP BI Launch Pad (formally InfoView), a SaaS
Administrator must log in to the BO CMC system and update the password for that user in Users
and Groups and assign appropriate user rights. An administrator of the BO system is typically a
SaaS Administrator for the customer.
When the SaaS Administrator starts looking at setting up the Business Objects Access
Provisioning, the following role suggestions can be used as a guide. We recommend that
Consultants during Implementation include a Maconomy group for each Business Objects role
and the SaaS Administrator ensures these groups are kept in Maconomy moving forward:
Universe Developer
It is recommended to have a role intended for users who need to develop and maintain universes
within Business Objects. In the Development environment, this role should give full access to
folders and tools to create and modify universes. This includes folders for LCM (Life Cycle
Management), the Report Conversion Tool, Visual Difference, and others. Accessible tools
include the Information Design Tool, Design Studio, Promotion Management, Lumira, and others.
Like the Sys Admin role, tools and access to modify content will not be available in Test and
Production environments. It is recommended that Universe Developers also have the role of
Report Developers. The Universe Developer role should have read access to connections as
other roles.
Report Developer
The Report Developer role contains the necessary access for users that need to create, modify,
and delete reports in Business Objects. It is recommended that this role provides access to the
necessary folders such as LCM (Life Cycle Management), the Report Conversion Tool, and BPM
\Development. Access to tools such as Lumira, Design Studio, Visual Difference, Upgrade
Management, and Web Intelligence can also be provided. As with other roles, tools and access to
modify content will not be available in Test and Production environments. The Report Developer
role should have read access to connections as other roles.
Ad-hoc Report Developer
This role is recommended to give users full access to their Personal Folder and the ability to
create and modify WebI reports. This allows users to modify existing reports and create new
reports from within WebI and save them in their Personal Folder. This can be done on the
customer’s production system. The Ad-hoc Report Developer role should have read access to
connections like other roles.
Report Viewer
Deltek recommends setting up a role to provide the necessary access for users to view Business
Objects content. This includes read access for folders that store content, connections, and tools
for this purpose. It is recommended that all users created by USync are given the role of Report
Viewer.
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Report Scheduling
You can submit a Support Case to enable scheduled reports/publications to email addresses.

Scheduling allows users and administrators to offload the processing of a document to the
backend server so that they do not have to wait for reports to refresh on-screen. You can
schedule a document to automatically run at specified times. When a scheduled document runs
successfully, an instance is created. An instance is a version of the document that contains data
from the time the object ran. You can view a list of instances in an documents history.
The best practice threshold to determine if a report should be scheduled is 5 minutes, (although
this may seem a little low). If a report takes longer than this to refresh and render, it is
recommended that you schedule it.
Benefits of Scheduling Reports

■ Provides lower waiting times when implemented correctly
■ Provides ability to offload processing to non-peak times
■ Reduces database impact during peak times
■ Functionality: Ability to schedule documents at pre-determined times (now, custom

calendars, selected day of the month, etc.) in a number of formats (Webintelligence,
Excel, .pdf, .csv) to a multitude of destinations (BusinessObjects, email, file system), and
the ability to be triggered by a custom event (For example, upon a database refresh).

BPM Scheduled Reports/Publications can be emailed to users. If you would like to enable
schedule reports to an email address as a destination, please submit a Support Case to specify
the From email address for such reports. A template for the Support Case can be found under 
Supported Ad-hoc Requests. SAP Business Objects Access Management
To schedule a report:

1. Log in to BI Launchpad.

2. Navigate to Folders and find the report you want to schedule.

3. Right-click the report name and select Schedule.

4. Under Options, modify the following:
■ Recurrence: Keep the default of Now to schedule immediately, or select as

appropriate.
■ Format: Select required format. The default value of Web Intelligence generates a

standard Webintelligence report.
■ Destination: Select Default Enterprise Location to have the report delivered in BI

Launchpad.

5. Click Schedule.
This will start the schedule and open an instance history window which will display the
status of the schedule.
Note that this window can be closed and you can check back on the status of the
instance by right-clicking on the report and selecting History.

Special Considerations
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■ Please consider performance when scheduling reports. Be weary of scheduling too many
reports at the same time, or with high frequency (For example, every few minutes).

If you need assistance with training to work with this feature, please refer to your Customer
Success Manager or Deltek Professional Services.

Custom Report Development
In addition to the standard BPM reports and universes provided by Deltek, users can develop
their own custom content.

Custom universes and reports should be saved in the relevant Custom or Development folder/
subfolder. Custom reports and universes that reside outside of these folders may not be
preserved following a system upgrade.
Development Folder
Available in development type environments only. This is the working folder where all universe
and report development should be saved.
Custom Folder
Available in all environments, this is where all finalized custom content should be saved. The path
of this folder is maintained across all environments.

Important: It is imperative that the default and standard Maconomy BPM reports and universes
remain unchanged and are not updated or overwritten during extension development
processes. If this does occur, then the affected reports and universes will be reverted back and
any custom changes will be lost at upgrade.

If required, the standard Maconomy BPM reports and universes may be copied to the
'Development' or 'Custom' folders; from here they can be modified for custom development.

Live Office Connection
Live Office is not activated by default. Please submit a ticket to request activation before
proceeding with the remaining information.

Note: All Cloud Customers will be updated from Business Objects 4.2 to Business Objects 4.3
in 2024. This update will ensure continued support of the Business Objects solution as well as
providing you with a more modern interface and additional functionality for report writers. The
Live Office tool will be deprecated with the update to Business Objects 4.3. Deprecation means
the feature will still be available throughout the BO 4.3 release. However, no new
enhancements are planned for this feature, and new Platform & Data source support will be
very limited.

Once you have downloaded the Live Office plugin, you will need to use the LIVE Office URL and
System Name specific to your organization to connect. The System Name can be found in the
email originally sent to you when your Enterprise Cloud system was setup. The Live Office URL is
formatted as ‘https://xxxbpm.deltekenterprise.com:8443/dswsbobje/services/Session’.
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For example if your Business Objects BI Launch Pad URL were ‘https://
abcbpm.deltekenterprise.com:8443/BOE/BI/’ your Live Office URL would be ‘https://
abcbpm.deltekenterprise.com:8443/dswsbobje/services/Session’.
For assistance with Live Office once you are connected, please contact your Account Manager or
Customer Success Manager to arrange for assistance from Deltek Global Services.
If you do not know your Live office URL or System Name or are not able to find them, please
contact Deltek by raising a Support Case in the Deltek Support Center. A template for this is
below:

1. Open Deltek Support Center and click on Submit Case

2. Use the following template to raise your RNT ticket:
■ Product » Maconomy – Maconomy Solutions
■ Severity Level » S4 – General
■ Issue Type » Application
■ Summary » “FAO DCO: “Provide Details for Live Office connection”
■ Detail » 

“Please provide me with the connection details for Live Office.
Environment Name/s:___________
System Name/s:_______________"

3. Click Continue and then click Finish Submitting Case.

Live Office Known Issue
There is a known issue with Business Objects Live Office in the Enterprise Cloud. Standard
reports cannot be opened from within Live Office. When opened, an error message is received.
This issue is awaiting a bug fix from SAP.
The workaround for this issue is to open the standard report in the BI Launchpad and save it from
there with the same name and content. This allows the report to be opened in Live Office. This
must be done for each report you need to run.

Ad-Hoc Reporting
You can run queries and use selection criteria to develop and generate ad-hoc reports.

It is possible to utilize the Business Objects BI Launch Pad for ad-hoc report development against
Production data. However, it is important to take note of the following:

■ Customer’s Responsibility: Queries that are utilized when developing and generating
ad-hoc reports are the customer’s responsibility. It is possible that a poorly written report
that is executed on the server could have a negative impact on performance. This is not
Deltek’s responsibility, and the user developing ad-hoc reports must not overlook this.
Deltek can help to triage and remediate these issues if a Support Case is raised.

The following restrictions apply to ad-hoc reporting and must be adhered to:
■ Manual SQL or report SQL amendments are not allowed.
■ Only universe based reports are allowed.
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■ Reports amended or written in production cannot be promoted to other environments.
■ Personal reports might be impacted after a universe upgrade.

Access to all items within the public folders (that includes all standard and custom reports) will
be read only. No one will be able to create or edit reports within the public folders.
A control group of people will have full access to their own BO personal folder. These users
should be able to copy a report from the public folders to their personal folder. The personal copy
version of that report can then be edited for personal use only. These users should also be able
to create their own report or query within their personal folder. This is based on standard and
custom universes (access to some universes might need restriction).

Warning: Ad-hoc reporting can adversely affect performance of the production system.

We recommend that selection criteria is used to ensure that only necessary data is fetched. For a
new report, start with narrow selection criteria and broaden it gradually to minimize the risk of a
long running report. If you expect a report to return large data sets and run for a long time,
schedule it to run outside of peak hours.
Please note that reports in the personal folder will not be taken into account when upgrading
standard or custom universes and reports.
All users:

■ Public folder = Read only
■ Personal folder = No access
■ Edit report = No access
■ New report = No access

Control group of user:
■ Public folder = Read only
■ Personal folder = Full control
■ Edit report = Edit standard/custom reports within the personal folder once copied from the

public folders to their personal folder
■ New report = Create new report in the personal folder based on existing standard and

custom universes

Warning: From Business Objects version 4.2 SP5 a (GDPR) data protection popup
message has been introduced.The message reads: "The product contains open or freely
configurable entry fields, which are not intended for storing personal data without additional
technical and organizational measures to safeguard data protection and privacy." End users can
silence this message by selecting “Do not show this message again”.
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SAP Business Objects Reporting on Mobile
It is possible to access your Business Objects reports in the SAP BusinessObjects Mobile app.

To set up reports for viewing on mobile:

1. Open the Business Objects Central Management Console (CMC).
2. Under Corporate Categories, create a new Mobile Category.
3. Identify the reports you want to make available on mobile and then assign the Mobile

category under Corporate Categories for each report.
4. Users will need to download the SAP BusinessObject Mobile application on their devices.

In Settings, they will need to add BO connection details and their User Name and
Password.

Analyzer Reports in Maconomy
You can run analyzer reports in Maconomy based on your selection criteria.

It is possible to run analyzer reports against data in Maconomy. Analyzer reports can be run by
those users that have access to them.
It is important to take note of the following:
Customer’s Responsibility: Queries that are utilized when generating analyzer reports are the
customer’s responsibility. It is possible that a report without sufficient selection criteria could have
a negative impact on performance. This is not Deltek’s responsibility, and the user running the ad-
hoc reports must not overlook this.

Warning: Custom analyzers are not permitted in Deltek Maconomy Enterprise Cloud.
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About Deltek
Better software means better projects. Deltek delivers software and information solutions that
enable superior levels of project intelligence, management, and collaboration. Our industry-
focused expertise makes your projects successful and helps you achieve performance that
maximizes productivity and revenue.
www.deltek.com

www.deltek.com Deltek
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